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Chapter 1 — Project Summary




Overview

Historically, wetlands were seen as inhospitable and an encumbrance to humans. In the U.S., we
have been extremely efficient at draining our wetlands and as a result have lost almost half of our
wetlands. In some areas, more then 90% of the wetlands no longer exist. We now realize that
wetlands are an extremely important component to our ecosystem. A few of the benefits include:
acting as a filter for cleaning water, providing flood control, providing habitat for over 300 fish and
bird species, and acting as a carbon sink.

The U.S. Fish and Wildlife Service (FWS) is the principal Federal agency that provides wetland
information to the public. Mapping wetlands is a key information component because it allows
resource managers to develop management plans, assess impacts, develop habitat models, perform
habitat surveys, and analyze trends. The FWS established the National Wetlands Inventory (NWI)
in 1974 to provide resource managers with information on the location, extent, and types of
wetlands.

The NWI for the Great Lakes was accomplished from the late 1970s to early 1980s. Updated the
NWI for the Great Lakes is imperative for conservation planning and habitat modeling for many
conservation organizations and natural resource agencies. However, with limited budgets, the FWS
does not have the funding to accomplish the update. Therefore, a consortium of public and private
organization is developing wetland mapping standards so that other groups performing wetlands
mapping can standardize methods for inclusion into the NWI.

Ducks Unlimited (DU) is leading a consortium of partners in the Great Lakes to accomplish an
updated NWI that can be used for multiple resource activities. DU is also working closely with the
FWS to develop efficient methods for tracking wetland changes over multiple time periods. The
goal of the NWI update for the Great Lakes is to provide a current wetlands data layer for habitat
modeling and resource management, identify potential areas for wetland restoration activities, and
to provide information on status and trends of wetlands.

Justification

Ducks Unlimited, Inc. (DU) and its partners have recently completed a research project in the Great
Lakes for breeding mallards. The results of the research were used to develop a planning tool that
allows resource managers to identify priority areas and acre goals for restoration, enhancement, and
protection of habitat in order to reach the Upper Mississippi River — Great Lakes Joint Venture
goals for breeding mallards. When implementing the habitat models and planning tool across the
Great Lakes, the limiting data layer was the availability of current and consistent wetland
information. This problem was recognized when comparing the 2001-2003 field information from
the mallard study to the NWI data. A current wetlands layer was also the limiting data layer in
another project on identifying all-bird conservation areas in the Western Lake Erie basin and the
Saginaw Bay Watershed. Additionally, DU and its partners are currently working on a two-year
research project on spring stopover sites for waterfowl and shorebirds — where wetland types play a
vital role.

In light of the past experience and anticipated future use of the NWI data, DU completed a pilot
project to update the NWI layer for part of Michigan with funding from the U.S Fish and Wildlife



Great Lakes Coastal Program and the Upper Mississippi River — Great Lakes Joint Venture. The
pilot project was performed to test the methodology for updating the NWI utilizing on-screen
digitizing and digital orthophotos over a large geographic area. The pilot project was successful and
has led to engaging other organizations (due to limited FWS funding) in implementing the update
for the Great Lakes. The need for this information is great and diverse as can be determined from
the current list of cooperators involved in the project — from transportation to environmental to
recreational.

Wetland Data

The primary source data for this project is the U.S. Fish and Wildlife Service’s National Wetlands
Inventory (NWI) which was accomplished using aerial photos from the late 1970s to 1980°s (see
Figure 1). The NWI does not exist for Wisconsin because the Wisconsin DNR was performing a
wetland inventory at the same time. For Wisconsin, the Wisconsin Wetlands Inventory will be used
for the update. For Ohio, some of the NWI is not in digital format and therefore needed to be
scanned and rectified before the update could occur.

=

i Date of aerial photos used to develop the original National Wetlands Inventory
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Figure 1. Dates of the aerial photos for the original NWI delineation




NWI Data

A seamless National Wetlands Inventory (NWI) data set is housed and administered by the United
States Geological Survey (USGS) in a Master GeoDatabase (USGS MGD) for the FWS. This data
set contains the most recent digital NWI data for the United States. When updated NWI data is
delivered to the FWS, it is uploaded into the USGS MGD and the original NWI data is archived.

For the State of Ohio, there are 610 USGS 1:24,000 quads that are not in the USGS MGD because
they are currently only available in hardcopy format. Most of the state of Wisconsin is also not in
the USGS MGD. NWI data was not done for Wisconsin because the State of Wisconsin was already
creating a wetlands layer — Wisconsin Wetlands Inventory (WW1). Complete coverage of Illinois,
Indiana, and Michigan are currently in the USGS MGD.

Ducks Unlimited received from the USGS a DVD with an ArcSDE export (check out date:
February 1, 2006) of the USGS MGD for the lower 48 States. This export was loaded into Ducks
Unlimited’s SDE database and clipped to the five state area using USGS 1:24,000 quads as the
bounding area (referred to as DU MGD throughout the remainder of the document).

Aerial Photos

Both spring and summer aerial photos will be used in the update process. The spring photos are best
to identify the seasonal wetlands and forested wetlands and the summer photos are best to identify
the emergent, aquatic, and farmed classes. The spring photos were typically acquired from state
agencies that contracted the photo flights. The summer photos were acquired from the Farm
Services Agency’s National Agricultural Imagery Program (NAIP). Digital Elevation Models
(DEM), hydric soils (from NRCS SSURGO data), and USGS Topographic maps may also be used
when available to aid in the updating process. For more information on the data and contacts for
each of the sections below, see Appendix B.

The Indiana NWI data will be updated using spring CIR photos from 2005 and summer natural
color photos from 2003 (NAIP). In addition, a high resolution Digital Elevation Models (DEM) was
obtained from the Indiana Geographic Information Council for the state to aid in the updating
process.

Ancillary Data

In cases where the wetland interpretation of the aerial photos is not clear, ancillary data can be
useful in determining the existence and class of the wetland. Ancillary data sets include
topographic maps, hydric soils, SSURGO Special features, and wetland restoration project sites.

USGS Topographic Maps

The digital raster topographic maps can be beneficial when identifying wetlands by looking at the
contour lines (wetlands don’t generally occur on slopes) and wetland symbols.



Hydric Soils

The Hydric soils attribute from the county level SSURGO soils can be beneficial when identifying
wetlands because most wetlands are going to occur on hydric soils.
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SSURGO Special Features

The SSURGO Special Features identifies special features (including wetlands) that are too small to
map within the soil polygons. Much like the wetland symbols on the topographic maps, this layer
can be useful identifying small wetland areas.

Wetland Restoration project sites

Ducks Unlimited has a point file for all of its wetland restoration projects. This layer can be helpful
in identifying newly created wetlands and determining the wetland class.

Project Timeline

The agreement was signed between the Indiana Department of Environmental Management and
Ducks Unlimited on November 29, 2007. The project completion date is August 31, 2009 with the
final report due on November 1, 2009.

11



Project Budget

The total cost to update the National Wetlands Inventory for the state of Indiana was $117,724.
Ducks Unlimited received a grant for $90,244 from the Indiana Department of Environmental
Management and for $12,500 the National Fish and Wildlife Foundation (via US EPA Great Lakes
Program). The remaining $15,000 was matching funds from Ducks Unlimited.
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NWI Master Geodatabase

The USGS administers a seamless version of the NWI as part of the National Map in an ArcSDE
master geodatabase for the FWS. The NWI master geodatabase is in Albers Equal Area projection.
All updates will conform to this projection system. DU received an export of the NWI MGD from
the USGS and imported the geodatabase into DU’s MGD. The exported NWI geodatabase included
all the available digital NWI data for the lower 48 states. This database was subset to all the USGS
1:24000 quads that intersect DU’s Great Lakes/Atlantic Region. This project will follow the
guidelines in the “Wetlands MGD Check-out Instructions” as developed by the FWS and USGS.

Database Setup

The National Wetlands Inventory (NWI) data is stored within a single database at Ducks
Unlimited’s Great Lakes/Atlantic Regional Office. The database, entitled ‘vector,” was created
using ESRI ArcSDE 9.1 SP1 and Microsoft SQL Server 8.0 software and resides on DU’s GLARO
network on the glaro_sde server.

The first steps performed upon configuration of the database server and data drives were to install
the database software, create the geographic data repository, and configure backups. Specific steps
are outlined below:

Software Installation

1. Microsoft SQL Server 8.0 was installed using Windows authentication. Tempdb is located
on the F:\ drive.
2. ESRI ArcSDE was installed.

Database Creation

3. In SQL Server Enterprise Manager, a new database named ‘vector’ was created to hold
vector datasets used at GLARO. The default Primary file location of G:\\MSSQL\Data was
accepted. The location of the transaction log was changed to E:\ in order to separate it from
the datafile drive.

4. Three filegroups were created. The SDE filegroup was made to contain the database’s SDE
system files. The NWI filegroup was made to contain the NWI data. Finally, the TOPO
filegroup was created to hold the topological data associated with the NWI data. A single
data file was created for each in G:\\MSSQL\Data.

5. Three separate database roles were created. The dataowner role was created for data
ownership. The dataeditor role was created to allow edits to the data. Lastly, the
databrowsers role was created to permit simple data viewing.

6. The ESRI ArcSDE post-installation software was run to create the SDE repository, to
authenticate the software, and to create a service.

7. Finally, the dbtune.sde file was edited to reflect the filegroup specifications outlined above.

14



Database Object Creation

Feature Class Creation

The U.S. Fish and Wildlife Service (FWS) delivered to Ducks Unlimited its NWI data as an SDE
export file (wet_poly feb_1 2006) containing all wetlands within the United States. To better
manage this data in the context of this project, wetlands outside Ducks Unlimited’s Great
Lakes/Atlantic Region Office region were deleted and new fields were added to record the update
process. This was done by importing the entire dataset, creating a duplicate shell schema with no
data, and appending desired data into the shell. The creation of a new feature class with these new
fields is outlined below:

1. The sdeexport file was imported using the following command:

sdeimport -o create -1 c_wet_poly_feb_1_06,shape -f\c_wet_poly_feb_1_06.000 -k nwi -i
vector_sde -u glarogis -p ********

2. The sdeexport file schema was exported by specifying a where clause condition that is not
met by any data. The following command was executed with the indicated results:

C:\arcgis\ArcSDE\sglexe\bin>sdeexport -1 ¢_wet_poly feb 1 06,shape -a all -f

C:\arcgis\ArcSDE\sqlexe\sdeexports\wet_poly _schema.sdx -w "ATTRIBUTE = 'Xxxx™" -i
vector_sde -u glarogis -p ********

ArcSDE 9.0 SQL Server Build 1926 Fri Mar 19 13:29:17 PST 2004

SDEX File Export Administration Utility

Exporting ArcSDE object to "C:\wet_poly_schema.sdx" in SDEX 9.0 export format ...
Exporting table "c_wet_poly feb 1 06".

Spatial column "SHAPE"

No matching records found or table is empty.

Only the table's schema information is exported.

0 features converted.

0 features exported.

3. The sdeexport file schema was imported into the vector database. The new feature class was
created and named ‘wet_poly.” The following command was executed with the following
results:

C:\arcgis\ArcSDE\sglexe\bin>sdeimport -0 create -1 wet_poly,shape -f
C:\arcgis\ArcSDE\sqlexe\sdeexports\wet_poly_schema.sdx -k nwi -i vector_sde -u glarogis

_p *khhkkkkk

ArcSDE 9.0 SQL Server Build 1926 Fri Mar 19 13:29:17 PST 2004
SDEX File Import Administration Utility

Importing SDEX from C:\arcgis\ArcSDE\sqglexe\sdeexports\wet_poly schema.sdx ...
Importing spatial column "shape”

15



5.

6.

0 record read.
0 record stored.

Features within the Ducks Unlimited’s GLARO region were appended to the wet_poly
feature class:
a. Merged USGS 24k shapefile features in GLARO region with

W:\GLARO\SDE _DATA\quad_areas.shp features that cover shoreline areas not in

USGS coverage to create coverage of GLARO region. Output as
W:\GLARO\SDE_DATA\quadareas_union.shp.

b. Selected quad features by state.

c. Selected c_wet poly feb 1 06 features that have their center in selected quad
features.

d. Using ArcToolbox Data Management Tools/General/Append, appended currently

selected features to wet_poly.
e. Cleared selected features.

Additional fields deemed necessary for the documentation of the update process were added

to the feature class. The added fields are:

NWI_KEY LONG INTEGER
STATUS SHORT INTEGER
CONVERSION_TYPE STRING (1)
PARTIAL STRING (1)
IMAGE_DATE STRING (15)
INACTIVE_DATE STRING (15)
FIELD_VERIFIED STRING (1)
COMMENTS STRING (255)
UPDATE_OPERATOR STRING (50)
UPDATE_DATE DATE

A ‘status’ subtype was created to apply topological restraints within the ‘active’ and
‘inactive’ subsets. To assign a topology rule to such subsets of data, a subtype must be
defined for the field. Therefore, a status subtype was assigned for the STATUS field.

Domains were created and assigned to support the projects data management guidelines. The

following domains were created:

Field(s): STATUS

Domain: Status

Field Type: Short integer
Code/Description: 0O/ACTIVE
Code/Description: 1/INACTIVE

Field(s): CONVERSION_TYPE
Domain: CONVERSION_TYPE

Field Type: Text

Code/Description: A/AGRICULTURE
Code/Description: D/DEVELOPMENT
Code/Description: R/RECREATION
Code/Description: O/OTHER
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Field(s): PARTIAL, FIELD_VERIFIED
Domain: Y/N

Field Type: Text

Code/Description: Y/YES
Code/Description: N/NO

Field(s): ATTRIBUTE
Domain: ATTRIBUTE
Field Type: Text
Code/Description: thd

Field(s): UPDATE_OPERATOR
Domain: UPDATE_OPERATOR
Field Type: Text
Code/Description: (per user)

8. A feature dataset was created to hold the wet_poly feature class and its necessary
topological rules. The dataset’s spatial extent was defined by importing the wet_poly feature
class’ extent.

9. The topological rules for the wet_poly feature class’ STATUS field subsets were created.
Features with the attribute ‘active’ within the STATUS field were given the topology rule:
“must not overlap.” Likewise, features with the attribute ‘inactive’” within the STATUS field
were given the topology rule: “must not overlap.”

10. The attribute values for certain fields were populated at the beginning of the update process.
The populated fields and their assigned values are listed below:

Set status for all features = 0/Active
Set NWI_KEY = OBJECTID
Correct 'ATTRIBUTE!' values

11. To utilize the NWI Object Inspector, an editing tool designed by GLARO to better enable
and standardize the update process (explained within the Process Management section of
this document), a change was made to an SDE system table for the wet_poly feature class
and checked-out feature classes. The GDB_ObjectClasses table was opened, and in the
record with name ‘WET_POLY:,’ insert the following in the EXTCLSID field:

{D6956100-2A7F-4999-B766-682E79BEB4FA}

Parent Table Creation

12. It was deemed necessary to record all parent-child feature relationships within the updated
NWI dataset. Therefore, a single table was created to record all parent-child relationships.
The new table was created using the glarogis schema. The table was created by executing
the following commands:

CREATE TABLE PARENT
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(

nwi_key int,

parent_key int,

unique (nwi_key, parent_key)
) ON NWI;

NWI_SEQ Table and Procedure

13. To ensure that newly created features within the updated NWI dataset are provided a unique
identifier, as were features within the original dataset, a database object was created that
would provide each newly created feature with a new and unique ‘NWI key.” The
NWI_SEQ table was created using the glarogis schema to provide NWI keys to newly
created features. The table was created by executing the following commands:

create table nwi_seq (ID int)
insert nwi_seq select 14079586

create procedure nextval

@ID int output

as

update nwi_seqsetID=ID+1, @ID=ID+1
go

Database Backups

The vector database on glaro_sde is used to store and serve data. Data is not typically edited directly
in the database. Instead, data is updated in a disconnected repository, with updates applied to a layer
in one operation. Because the data is not actively edited in the database, log file recovery is not
needed. Therefore, the vector database is set to the Simple recovery model. A full backup is taken
every weekend, with differential backups taken every night. Additionally, the log file is truncated
nightly.

GLARO uses the vector database to store and serve multiple feature classes not pertaining to NWI.
Therefore, in the event of an editing or data synchronization error, it may not be prudent to restore
the entire database in order to retrieve one data layer. Consequently, the wet_poly feature class,
which is the only feature class that undergoes regular edits, is exported every weeknight. Exports
are saved for a full week, after which point they are overwritten. Also, one export per week and one
export per month are archived. If necessary, these exports may be used to restore the wet_poly
feature class only.

Database Maintenance

The wet_poly layer and database undergo periodic maintenance for which all users check in their
edits that are then reconciled and posted. After all versions are deleted, the database is compressed
(as the SDE user) and the layer is unregistered as versioned (as the dataowner). This writes all data
updates to the wet_poly table. After this is done, the wet_poly feature class is analyzed and the
feature dataset is then re-registered as versioned.
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As routine, the parent table is inspected for NWI key/parent key combinations recorded that no
longer exist. Periodically, queries are run to verify that the NWI key and parent key features both
still exist. Orphaned records are deleted.

Geodatabase Versioning

The DU MGD administrator is the only person that has permission to edit the DU MGD. The DU
MGD will be registered as versioned, which will allow multiple users to edit the data
simultaneously. Analysts will edit a version of the master database, not the actual database (see
Figure 1). The version will appear the same as the original, however, instead of being a copy or
modifying the original data, edits are stored in separate geodatabase system tables. The DU MGD
administrator will only post edits after any conflicts have been reconciled and the edits have been
checked for quality (see QA/QC section).

Data Editors

As GLARO employs a multitude of interns and volunteers to assist in the update process, additional
data editors are commonly added. The following steps detail the creation of a new NWI Update data
editor:

Create a login for the new data editor

1. Open the SQL Server Enterprise Manager on glaro_sde.
2. Expand navigation tree to Local Server > Security > Logins
3. Right-click on 'Logins’ and select ‘New Login..." Make the following entries and click 'OK":
Login name
SQL Server Authentication
Password
Database: vector

Create a user account for the new data editor

4. Navigate to Local Server > Databases > vector > Users

5. Right-click on 'Users' and select 'New Database User..." Make the following entries and
click 'OK":
Login name: Select login created in step 1.
User name: User name will automatically populate with the login name.

6. Database role membership: public will be checked by default, also grant the sde_dataeditor
role.
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Data Model

Geodatabase Feature Dataset
Spatial Reference is as follows:

Projected Coordinate System:
Name: NAD_1983 Albers
Alias:
Abbreviation:
Remarks:
Projection: Albers
Parameters:
False_Easting: 0.000000
False_Northing: 0.000000
Central_Meridian: -96.000000
Standard_Parallel_1: 29.500000
Standard_Parallel_2: 45.500000
Latitude_Of Origin: 23.000000
Linear Unit: Meter (1.000000)
Geographic Coordinate System:
Name: GCS_North_American_1983
Alias:
Abbreviation:
Remarks:
Angular Unit: Degree (0.017453292519943299)
Prime Meridian: Greenwich (0.000000000000000000)
Datum: D_North_American_1983
Spheroid: GRS 1980
Semimajor Axis: 6378137.000000000000000000
Semiminor Axis: 6356752.314140356100000000
Inverse Flattening: 298.257222101000020000

X/Y Domain:
Min X: -3350595.000000
Min Y: -729611.000000
Max X: 18124241.450000
Max Y: 20745225.450000
Scale: 100.000000

Data Dictionary

One of the challenges in updating the NWI is to design a system that tracks the historic wetland
information so that wetland trends and potential restoration sites (wetlands that have been
converted) can be identified. A solution was developed by adding attributes to the current database
that identified the converted and partially converted wetlands. These additional attributes allow for
flexibility in selecting current NWI polygons, historic wetland polygons, or a combination of both.
This system also allows for easy tabulation of the current status of wetlands, wetland trends, and
identification of converted wetlands for potential wetland restoration activities. Therefore, several
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attribute fields will be added to the DU MGD (see Table 1 and Figure 1). For a more detailed
description on how the attributes are used, see the “Update Procedures” documentation.

The updated NWI database includes a number of attributes for each wetland feature. Some of these
attributes were of the original NWI data. However, as previously discussed in this document,
GLARO added a number of attributes to assist in the documentation and management of the update
process. A full list of attributes and their definitions follows: Those in italics were added to the
FWS layer by Ducks Unlimited.

WET_POLY

OBJECTID OID (4)
ATTRIBUTE STRING (20)
HGM_CODE STRING (10)
QAQC_CODE STRING (9)
WETLAND_TYPE STRING (50)
ACRES DOUBLE (8)
DECODE STRING (40)
NWI_KEY LONG INTEGER
PARENT_KEY LONG INTEGER
STATUS SHORT INTEGER 0/1
CONVERSION_TYPE STRING (1) A/D/RIO
PARTIAL STRING (1) YIN
IMAGE_DATE STRING (15)
INACTIVE_DATE STRING (15)
FIELD_VERIFIED STRING (1) Y/N/NULL
COMMENTS STRING (255)
UPDATE_OPERATOR STRING (50) *
UPDATE_DATE DATE DEFAULT
SHAPE GEOMETRY (4)
SHAPE.area DOUBLE (0)
SHAPE.len DOUBLE (0)
OBJECTID Automatically generated feature id.
ATTRIBUTE Habitat classification
HGM_CODE Code generated by the U.S. Fish and Wildlife Service
QAQC_CODE Code generated by the FWS QA/QC tool
WETLAND_TYPE Text field describing the NWI wetland
ACRES Acreage
DECODE Link to the NWI online decoder
NWI_KEY Unique id for wetland features
STATUS Current status of the feature, either Active or Inactive
CONVERSION_TYPE Purpose for which a wetland was converted, either Agriculture,
Recreational, Development, or Other
PARTIAL Was derived from a prior wetland
IMAGE_DATE Vintage of imagery used to create polygon

INACTIVE_DATE
FIELD_VERIFIED

COMMENTS

UPDATE_OPERATOR

UPDATE_DATE

Vintage of imagery used when polygon was inactivated

Whether or not the wetland has been verified in the field, either Yes,
No, or Null

Comments

User that made updates

When updates where made
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Primary/Foreign Keys, Cardinality, Relationships

There is a many to many relationship between the wet_poly table and the parent table. The nwi_key
field in the wet_poly object is the primary key while the nwi_key field in the parent table is the
foreign key.

Domains

Field(s): STATUS

Domain: Status

Field Type: Short integer
Code/Description: 0O/ACTIVE
Code/Description: 1/INACTIVE

Field(s): CONVERSION_TYPE
Domain: CONVERSION_TYPE

Field Type: Text

Code/Description: A/AGRICULTURE
Code/Description: D/DEVELOPMENT
Code/Description: R/RECREATION
Code/Description: O/OTHER

Field(s): PARTIAL, FIELD VERIFIED
Domain: Y/N

Field Type: Text

Code/Description: Y/YES
Code/Description: N/NO

Field(s): ATTRIBUTE
Domain: ATTRIBUTE
Field Type: Text
Code/Description: (per user)

Field(s): UPDATE_OPERATOR
Domain: UPDATE_OPERATOR
Field Type: Text
Code/Description: (per user)
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Chapter 3 — Editing Environment
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Database Connection

This section details how to set up the editing environment in ArcGIS. These steps need to be

performed one time only.

Step 1: Set up Database Connections in ArcCatalog

1. Launch ArcCatalog

2. Expand Database Connection in the catalog tree, double-click on 'Add Spatial Database
Connection’, enter the following parameters in the dialog, and click 'OK":

Spatial Database Connzciion

SeEvern I'Iﬂ.m'l Dk
Sewice {5161
D stabissse. |
'
Futer he weerimamne awl Vi ppueac Dry ik (b2l
prersvrensd et yom Accourt
rereived fiomn rhe gie e lglangis \
audlindnistrotox
Passw Imaﬁ:rnnml /f
S S avahEme Password Tes Conpection
Eo e to unehack
"Fave Version” i
h"‘“‘hﬁh - Wersion
[ SaveVesion

I L I

Goge,

Cancel I

3. Repeat Step 3, using Service: 5152, but leaving ‘Save Version’ checked:
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Spatial Database Connection

Server |glan:u_sde
Service: |5'| 52
D atabaze: |

[If zupported by your DERS]

Account
Uzer Mame: |EI|E"'3'EIiS
Passwiord: | xxxxxxxxxx
[v 5ave Mame/Pazsword Test Connection |
Werzion

v Save Wersion

zde.DEFALLT Change. ..
] | Cancel |

Step 2: Add Editor and Disconnected Editing toolbars

If the Editor and Disconnected Editing toolbars are not present in the ArcMap user interface, they
need to be added. First, check for the presence of the following toolbars:

Editar = M | j | j

Disconnected E...[¥]

HES D

If one or both do not exist, go to View > Toolbars and check 'Editor' and 'Disconnected Editing'.
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NWI Object Inspector Installation

Edits made to feature classes that are derived from the wet_poly layer must be made using the NWI
Obiject Inspector. This custom attribute editor includes changes to the attribute dialog, plus actions
triggered by editing events.

Installation

1. Navigate to \\Drake\Archive\lnstalls\GIS Misc\NWI\NWI Object Inspector and execute
Setup.exe. Follow the steps in the installation wizard to install the application.
2. Edit the registry
a. Go to Start > Run, and type ‘regedit’. Click ‘OK”.
b. In the Registry Editor, navigate to My
Compute\HKEY _LOCAL_MACHINE\SOFTWARE\DU\NWI:

%" Registry Editor

File Edit Yiew Favorites Help

= B My Computer A 1 name T Data
'+ Cl HKEY _CLASSES_ROOT | @(Defauk) RES 57 fvalue nok set)
;+ g :EE:_fSI?EI_ENI\:A_ga?SE E‘_’jﬂttributes REG_SZ2 FUE, PEM
Tt = [3B]1mageDate REG 57 2005
; B g:ﬁDWARE [#b]UpdateCperator  REG_SZ bshaman
[ SECURITY
=[] SOFTWARE
=23 781
@ AcT
(] Adobe
-2 Adabe Systems
|+ CI Apache Group
& D Arcana Development
[ (1 Aso
- ATI Technologies
(3 Borland
{3 Broadcom
(] Business Chijects
= [ co7ftsy
[ (1 CoDB
(] Classes
(] Clients
] [ Creative Tech
- [] Crvstal Decisions
=] (2 cyberLink
|+ CI Drart
|+ CI DrataEast
-] el
[ Dell Computers
[ Description
={1ou
Rl |
-] Earth Resource Mapping
(] Erdas
-3 ESRI
{3 FLEXIm License Manager

R

My ComputeriHKEY_LOCAL_MACHINE|SOFTWARE|DLINWI

c. Edit each of the three registry keys by double-clicking on the ‘Name’ value, editing
the text, and clicking ‘OK”.

i. Attributes Enter attribute values desired in the Attribute combo
box. Separate each value with a comma.
ii.  ImageDate Enter the vintage of the background imagery for the

state you will be working
iii.  UpdateOperator Enter your database username. This follows the
naming convention <first_initial><last_name>.
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Using the Object Inspector

The Obiject Inspector is the tool that ArcMap uses to edit the attributes of a selected feature during
an edit session. DU has customized the standard Object Inspector for the NWI update to improve
the efficiency of the update process.

Edit Session

Upon commencement of an editing session, the Object Inspector will determine whether you are
editing NWI data or not. If you are making NWI edits, it will automatically capture edit events that
properly manage your data.

Attribute Edits

All attribute edits made during an edit session must be made through attribute edit window (Object
Inspector). Do not make any attribute edits via other means:

| = Benzie_Wet_Poly | [ Aftributes i Global Yariahles
I PFOB

Atribute: |FFoB ~|
M Key: |3z81601
Parent Key: |
Status: |A|:1|\.fe ﬂ
Conversion Type | ﬂ
Partial: | ﬂ
Field Verified: | ]
Image Date: |19?5
Inactive Date: |
Comments:

“I features

Edits to Multiple Features
Just as with the standard attribute editor, edits can be made to multiple features at once. To do so,

click on the layer header in the left panel. Edits made to any attribute will apply to all selected
features:
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tiributes

- Benzie_Wet_Poly
+-PFOB
+-PFOB
+-PFOB

Attributes

T Global Variables

3 features

Image Date:

Inactive Date:

Adribute: | |
Nl Key |
Parent Key: |
Status | |
Conversion Type: | ~|
Parial | =]
Field Varified: | =]
|
|

Comments:

Global Variables

The global variables need to be set when the analyst first starts a county. The update operator will
be set based on the login name, be sure this is set to the proper name. The image date will be the
date that is filled in for the Inactive Date if a polygon is inactivated or for the Image Date if a new
polygon is created. For Northern Ohio, the image date should be set to 2006 and southern Ohio,
2007. Indiana and Illinois the image date should be set to 2005. For Michigan, the image date
should be set to 1998, with manual updates to 2005 when changes occur. Attributes that occur
frequently (ponds — PUBGX) can be placed in the attributes box. These attributes will show up in
the pull down menu for quick assess. There are over 2,000 unique NWI attributes, so it would not
be efficient to put all of the attributes in the pull-down menu.

LLFDUTES

- Benzie_Wet_Poly
+ PFOB
+ PFOB
+ PFOB

3features

Alftributes

Update Operator:
Image Date:

Adtributes:

| Global Variables
rmacieod
1938
PUBGx PEMF,
PEMC PEMA
PFOICPFOIA
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Edit Operations

The nwi key and parent key(s) are managed during Create Feature, Copy/Paste, Cut, and Clip
Polygon edit operations. During all other edit operations, the nwi key and parent key(s) must be
managed manually.

Create Feature
When a feature is created, the Object Inspector automatically populates the NWI key, Status, and
Image date.

, = : %]
# 4624032 e _jv

RO Key e

Parent Key: ,-—“

Stat m

e — Automatically

Field Yerified: ,‘ﬁ pop u I ates the

Image Date: ]WBHB—-

Inactive Date ’7 NW I Key’
Status, and
Image Date

Copy and Paste
When a feature is copied and pasted, the copied feature is automatically made inactive, and the
parent key for the new feature is set to the nwi key of the copied feature.

= W oLy T
winse BN ~l Automatically
i A populates the
=T -] NWI Key, Parent
oatel = Key, Status, and
eiavried | - Image Date for
e the new polygon,
and inactivates
the original
. polygon
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Clip Polygon
When a feature is clipped, the Object Inspector automatically populates the NWI key, Status, Image
Date, and Parent Key, if applicable.

Hiributes

: EE;(C: Adtribute: W“—E
W Ky 14773343
Parent Key: 14773337 .
Er— Automatically
'——]ﬁ populates the
Field “erifiad: i . NWI Key, Status,
e | Image Date, and
Inactive Date: ’—‘ : g ,_
.CDmmems Parent Key If

applicable

Attribute

The attribute field contains a drop-down list of often-used values (add new values in the Global
Variables tab). Any of these values may be selected, or the user may type in a new value. The list
may be edited by added and deleting codes from the Global Variables tab.

NWI Key

The NWI Key is locked from editing by the user. This field is autopopulated by the application for
new features. The value in this field can be copied and pasted into the parent key field. See section
on “NWI Key Updates” if you need to change the NWI key for a feature.

Manual NWI Key Updates

For special cases where NWI Keys were not automatically updated, a utility has been created to do
S0.

Installation

1. Open ArcMap and create a map document that includes the NWI personal geodatabase
feature class that will receive updates.
2. Open the *Customize’ dialog > Comments tab. Select the target map document or template.
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Click *‘Add from file’, navigate to V:\Installs\GIS Misc\NWI\UpdateNWI1 and select
UpdateNWI1.dlI.

4. Drag the UpdateNWI command button onto the toolbar:

= Lintifled - Arebap - Arelnls

o e few et Selecton Jooh Wedoss bk

— R NERED $%9% P@

DFU@ s k@X o B ¥ JAaDw AT A]
REREDDEBB0R] B E &EY g b ] =] | ot | 370 noe
|

bt 1 |
# LR gyt
e toud

Feories [ Indk | Samch
oo [Homalmt v  Eebosd. | sodwomie | e
Display Sourcs | Salecion 1ICE) o]
g k Chad O~ A~ X |d6las w0 =] mor oy A N s

B Frhed Grodatebaies | BB Undatenaw

Use

5. Select the features to be updated.
6. Click on the “NWI’ button.

Note: The Update NWI tool will function whether there is an active edit session or not. If there is an

active edit session and the Object Inspector is visible when the tool is run, the Object Inspector will
not be present when the tool completes, even though the edit session will still be active.
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Chapter 4 — Overview of Updating Process
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The NWI layer will be updated using spring and summer digital orthophotos. The spring photos are
best to identify the seasonal wetlands and forested wetlands and the summer photos are best to
identify the emergent, aquatic, and farmed classes. Digital Elevation Models (DEM), hydric soils
and USGS Topographic maps may also be used when available to aid in the updating process. Only
wetland polygons will be updated (no lines or points), as the Wetlands MGD Check-out Instructions
(USFWS, 2004) state; “Linear delineations of wetlands are discouraged” and “The wetlands MGD
will no longer support wetland point features.”

The updating process will involve displaying the original NWI1 layer on top of the digital
orthophotos on a section-by-section basis (1 square mile, approximately 1:10,000). The minimum
mapping unit for the update is approximately one-tenth of an acre. The photos will be interpreted as
to whether the wetland still exists, if it has changed class, has been spatially modified, or remains in
the same condition as the original. A unique system to track the changes to the wetlands was
devised through the use of a NWI key and parent key (see Figure 4) A photo interpretation key and
the existing NWI data will be used to assist the interpreter in determining the wetland condition and
class.

Any wetlands that were either missed by the original NWI or have been created will be digitized
and attributed. All existing wetlands that do not spatially register with the digital orthophotos will
be modified to match the photo. “New” and modified wetlands will be classified to the class level of
the NWI classification scheme according to the USFWS NWI Photointerpretation Convention. The
water regime will be attributed to the best of the interpreter’s ability and the special modifiers will
be attributed when necessary. When the interpretation is possible at the subclass level, they will also
be included.

If there is confusion as to the wetland type or condition during the photo interpretation process, they
will be flagged for field verification in the database. A map of the flagged wetlands will be
produced and sent to cooperators or DU field staff for field verification. Once field verified, the
attributes will be updated and the verification process will be noted.

The first step in the NWI updating process is to receive a copy of the USGS NWI Master
Geodatabase (MGD) and import the database into DU’s Geodatabase (DU MGD) (see Figure 5 for
an overview of the NWI process). The photo interpreters will be updating the NWI on a county-
wide basis, therefore, the second step is to have the photo interpreters “check out” a version of the
MGD for their county to perform the update. Once the update is completed for their county, the
third step is to run a QA/QC process to verify the attributes and spatial integrity. The fourth step is
to perform the field verification and circulate the draft update for comments from cooperators. The
fifth step is to post the version back to the DU MGD. The final step is to return the updated NWI to
the USGS MGD. For a more detailed discussion on the geodatabase (DU MGD) and update
process, please refer to the “Data Management” and “Update Procedures” documentation.

Following Figure 5 there is a procedural checklist that lists the steps for the NWI update. The
remaining chapters will document the process for completing these steps.
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NWI Key/Parent Key Example

Time 1

OBJECTID

NWI Key = 101 |

OBJECTID

DRAINAGE_TYPE

PARTIAL

IMAGE_DATE 1978

NWI Key = 102
Parent Key = 101

FIELD_VERIFIED

TV OO T

COMMENTS

FIELD_VERIFIED

COMMENTS

UPDATE_OPERATOR

UPDATE_DATE

UPDATE_OPERATOR RDM

Status becomes
inactive (1) if there
is a change in future
updates

UPDATE_DATE 2005

A new polygon is created
that can be linked back
to original data through
the Parent_Key

Figure 4: Wetland tracking over time.
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Time 2

Time 3

OBJECTID NWI Key = 102
NWI Key = 103 Parent Key = 101
Parent Key = 102 | | Status = inactive
Conversion = A
e —cs Partial = Yes

If a polygon needs to be

split, both of the new polygons
can be linked back to the original
data through the Parent_Key



County checked

USFWS NWI Master out for editing .
Geodatabase

(USGS MGD) Database VEd“_ab'e f [ county | _
sent to DU ersion o "|  Editor
database
Database returned [ county | |
DU NWI Master .
Geodatabase
(DU MGD) Update .| County [ | Editors
Editor update
Final Process NI
QA/QC SEEEE
o County | |
A Editable Editor
SASZSS Version of —
n database Corrections
Update
P made .| County | |
Y Verification g " Editor
process
FiehA il QAIQC |

Sites

Verification Selected

Version run through
quality assurance

Figure 5. The NWI update process.
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NWI Update Procedural Checklist

CHECK OUT PROCESS

(11 Pl checks out county from DU NWI Geodatabase

D 2) Pl updates NWI status layer for county (Status = “In Progress”)

UPDATE PROCESS
D 3) Pl performs update on county
D 4) Pl(zy runs QA/QC tests
D 5) Pl visually checks 10% of grids in county
@

D 6) Pl submits county to Analyst for QA/QC
[ ] 7) Analyst performs QA/QC and checks in data

D 8) Analyst updates NWI status layer for county (Status = “Complete”)
D 9) DBA post draft data on web site

FIELD VERIFICATION PROCESS

10) Pl updates NWI status layer (Verified -= “In Progress”)

11) Pl runs field selection process
12) Pl produces field maps

13) MAN enter maps into database
14) MAN sends maps to cooperators

15) Pl organizes field data and adds field data to the point file

1 O O 0O O Odo

16) P13 updates assessment table with field results
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D 17) Ply verifies field data and update/correct NWI layer
D 18) Pl submits verified county to Analyst for final QA/QC
D 19) Analyst performs QA/QC

D 20) Analyst updates NWI status layer (Verified -= “Complete”)

INTREGRATION BACK INTO FWS NWI
D 21) Analyst prepares data to be sent to FWS
D 22) Analyst performs final QA/QC
D 23) Analyst creates metadata
D 24) Analyst sends data to the FWS

D 25) Analyst updates NWI status layer (Status = “Final”)
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Chapter 5 — Check-Out Process
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Create the Data Repository

1. Launch ArcCatalog and create a personal geodatabase to hold your edits. Store the
geodatabase in D:\Working and use the naming convention County ST.

Add Data to ArcMap

1. Launch ArcMap

2. Add data from database connection (Database Connections > Vector > NWI)

3. Add feature datasset vector. GLAROGIS.NWI. This will include the WET_POLY feature
class, as well as a county layer and a reference grid.

4. To symbolize, right-click on layer and select 'Properties'. Click on the 'Symbology’ tab.
Symbolize active and inactive features as desired.

5. Add imagery and other pertinent data (hydric soils, topographic map, etc)

Check Out Data for Edits

ArcGIS manages data edits by multiple users by implementing "versions" of data layers. Rather
than making edits directly to the wet_poly layer, editing is performed on disconnected versions of
the data which are stored in personal geodatabase format. Each user creates and edits a copy, or
version, of a feature class. Upon the completion of each county, the data administrator will

reconcile edits and post them to the master data layer. The users then create another version, and the
process begins again.

Step 1 & 2 below can be skipped by using the CheckoutSelection tool. This tool performs the
selection process and you can skip to Step 3. To add this tool to your tool bar, select Customize
from the Tools pull down menu in ArcMap.

Toolbars Commands ‘ Options ]
Show commands containing: ||
Categories: Commands:
3D Analyst - #4330 Analyst Layer List Control
3D View Add Features to TIN...
Adjustment Area and Volume...
Advanced Edit Tools #= Contour Tool
Animation Create TIN From Features..
ArcPad Features to 30...
im?mrﬂb E Interpolate Line Tool
rc ' aolbox 2 Interpolate Point Tool
Aftribute transfer =
CAD - Interpolate Polygon Tool
Cadastral <#+Line of Sight Tool
Pt P e b Matural Meighbors...
Savein: |MNormalmaxt ﬂ Keyboard... Add from file... Close
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Then click on the “Add from file” button at the bottom of the form. Navigate to V:\Installs\GIS
Misc\NWI\CheckoutSelection and select the “CheckoutSelection.dll” file. From the Comands box
on the form you should see the text “CheckoutSelection”. Drag and drop this onto your toolbar.
When you click on this button on your toolbar, it will ask you for the state and county you would
like to select. You can then skip to step 3.

Select a County B|
sate | | =
County ‘ j
Cancel | Execute |

1. Select the target county.
2. Under Selection > Select by Location, select all features from the WET_POLY and
NWI_RefGrid_2000m layers that intersect the selected features in NWI_County:

Select By Location

Letz you select features from one or more layers bazed on where they are located
if relation to the features in another layer.

| want to:

|seleu:t features fram ﬂ
the following layer[z):

YECTOR.GLARDGIS WET_POLY

vector GLAROGIS. Mw_RefGrid_2000m
1 wector. GLARDOGIS. Mw|_County

[ Only show selectable layers in thiz list

that;
|intersect ﬂ
the features in thiz lager;
| vector, GLARDGIS. Nwi_County -l
v Use zelected features [1 features selected]
[ Apply a buffer to the features in vector. GLAROGIS. Nw_County
| | e
Fresig

The red features represent the features in vector. GLAROGIS. M _County.
The highlighted cyan features are zelected becauze they
intersect the red features.

OO Q 6’50\/)

Paintz Lines
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3. Click on the 'Check Out' tool on the Disconnected Editing toolbar:
Disconnected E...[X]

4. Indicate the geodatabase as the output location. Name the check-out with the name of the
county and state. Leave all other parameters unchanged and click 'Next':

Check Out Wizard

Thiz wizard lets you check out data from thiz geodatabase to another geodatabase where it can be edited.
By default, all feature claszes and tables in the map are checked out, along with any related data.

Checking out data from: GLAROGIS. glarogis - glaro_sde
* [ata
" Schema Only

Wwhich geodatabaze do you want to check out to?
C:APragram FileshAacG1SbinCheckOut_Output. rmdb =

[ Be-use schema if the geodatabasze alieady containg the schema for the check-out

What do you want to call this check-out?

|D upage_IL|

[ Show advanced options for overiding check-out defaults when | click Mext

About Checking Out D ata

| Mest » | Cancel

5. On the second window, check 'Change the layers and tables to point to the checked out data'.
Click 'Finish':
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Post Check Out Options @E|

YWhat do you want to do once the check out has been completed?

" Mo further action

{* Change the layers and tables to paint to the checked out dats

Save a copy of this map document with the layers and tables pointing at
the check-out data:

- |

Summary...

< Back | Finizh | Cancel

Now, all edits will be made to the new version of WET_POLY.
6. Save the map document (.mxd) file.

Update NWI Status Layer

In order to keep our cooperators informed of the status of the NWI update project, we have created
a web page with a ArcServer application to identify which counties we are currently working on
and which ones are completed. The ArcServer application uses the NWI Status layer within our
Geodatabase to create the map. Once you check out a county for the updating process, you will

need to update the NWI Status layer for that county.

1. Add the NWI Status layer to ArcMap Database Connection > Vector > NWI Other > Status

2. Start Editing
3. Select County and change the status to “In Progress”
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Editor v & | M #|~ Checkout Selection £ e B 0 (5) o (@ Task: | Create New Feature ¥ | Target: | vector.GLAROGIS.Statu ¥

x

-l £ Layers
= vector. GLAROGIS. Status
[ =al other values>
STATUS
I Completed
M Final
=i Progress
= vector.GLAROGIS. Status | Property | Vae
#-Barry OBJECTID 403
NAME Barry
STATE_NAME  Michigan
STATE_FIPS 26
CNTY_FIPS 015
FIPS 26015
STATUS <Null=
VERIE[ED ——
Shape.area
Shape.len
|‘I features < 3
Display | Source | Selection 5| 202 0y

Status Layer Definitions

Status
In Progress - County has been checked out and the update is currently taking place

Complete - County has been QA/QC’ed and checked back into the geodatabase
Final - Sent to the US FWS for inclusion in the NWI MGD
Verified
In Progress - Wetlands have been selected for field verification and maps have been sent to
cooperators
Complete - Field verified wetlands have been checked, point file has been created,

wetlands have been updated, data has been checked back into the
geodatabase.
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Chapter 6 - Update Process
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County Updates

The NWI update will be performed on a county by county basis. Preferably no two counties will be
checked out at the same time due to overlapping wetland polygons.

Reference Grid

A square mile reference grid was created to track the progress of the NWI update through the
county. The grid size was created so that one grid would be viewable at 1:10,000 on the monitor.
Once the analyst completes the grid, a graphic is placed in the grid cell to identify its completion.
The grid allows the analyst to keep track of the progress and aids in quality control.

Creating a New Feature

Interpretation

The first step in creating a new wetland feature is to identify an unidentified wetland in the aerial
photography. In this early spring color infrared image, there is dark area in an agricultural field.
This area has different coloring and texture than the surrounding farm field. Also, it does not have
plow lines going through it, suggesting that it is too wet to be farmed.
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The same area is shown in a summer true color image. This is a good example of an emergent
wetland.
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Digitize the Feature

1.

2.

3.

To digitize this area, click on “Start Editing’ in the Editor drop-down box on the Editor
Toolbar.

Make sure the Task is set to ‘Create New Feature’ and the Target layer is set to
‘WET_POLY:ACTIVE’.

Using the Sketch tool, digitize the area around the feature.

Update the Attributes

4.

Open the attribute window either by right-clicking on the polygon and selecting
‘Attributes...” or by clicking on the Attributes button on the Editor toolbar. In the Attribute
window that opens, input an appropriate habitat classification value either by selecting the
code from the drop down box or by typing it in. The feature in the example has been coded
as Palustrine Emergent, which has a code of PEM. Please refer to the Photo Interpretation
Guide for determining which NWI code to call the wetland.

Note that by default, all newly digitized features will be assigned an NWI Key and will be
given a Status of *Active’.

Attributes [x]

E = = B_enz'le_Wet_Pory Attributes T Global Wariahles
- PEMC
Adtribute: [PEMC ~]
N Key: [14732778
Parent Key: I
Status: IAcﬂve LI
Conversion Type: I LI
Fartial: I LI
Field Verified I LI
Image Date: |1 993

Inactive Date: I

Comments:

- ||1 features
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Modifying a Feature (Full)

Interpretation

In the lower left corner of the following image, the PUBGX polygon is too small for the current size
of the excavated wetland. In this situation, we must replace the existing polygon with a new, larger
one that properly represents the current state of the wetland. The original feature will be assigned a
Partial value of “No’ and no conversion type indicating that the wetland was modified either
spatially or a change in class (emergent to shrub). This change will most often occur with a change
in the NWI code (see next example).

Inactivate the Old Feature
1. Select the polygon and open
the Attribute window. Make
the following changes:
e Status = Inactive
e Conversion_Type = Null

e Partial = NO
2. Copy the NWI Key to the
clipboard.

Create the New Feature

3. On the Editor toolbar, set the task to ‘Create New Feature’.

4. Using the Sketch tool, draw a new polygon around the wetland area.

5. Paste the copied NWI Key from the inactivated polygon into the Parent Key field of the new
polygon. This indicates that

the new wetland feature was
created out of the loss of the
old.

6. Enter the habitat
classification for the new
feature in the Attribute field.
In the example, the new
wetland has been classified
as a Palustrine
Unconsolidated Bottom,
Permanently Flooded and
Excavated, indicated by a
code of PUBHX.

i)
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In the following example, the selected polygon was labeled PFOY. From the Spring CIR imagery
and the summer natural color imagery you can see the tree shadows from the surrounding forest in
the SE portion of the selected polygon. This indicates that the polygon is probably not a forested
class and should be labeled as a shrub class. This polygon will be copy and pasted with the original
PFOY polygon inactivated with no conversion type and partial equal to “No”. The new polygon
will be labeled as PSS1B with the parent key copied from the NWI Key of the PFOY polygon.

rtributes (%] Atiributes

= Benzie_Wet_Poly Atftributes | Global Variables = Benzie_Wet_Poly Attributes Global Variables
# PFOY =-PFOY
- PROY Atributs [fFov— ~] - PSS18 Aibute fssie +]
N Ky i =] KA Ky [ta7azeos
Parent Key: i— Parent Key: W
e e — St Foe =
Conversion Type: I—L] Conversion Type: ]—A'_-I
Partial Ha Bt Partial: ':
Field Werified X Field Werified et
Image Date i]g;ﬁg—‘ Image Date Fg“g]-é—‘
Inactive Date: ﬁ“gég—" Inactive Date: '—“
Cornments Comments
2 features 2features
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Modifying a Feature (Partial)

Interpretation

In the image to the right, a PFO/SS1C polygon is
partially overlapping a newly excavated area. In this
case, the original wetland has partially changed its
form. The original feature will be inactivated and will
be assigned a Partial value of “Yes’, indicating that
the existing wetland evolved from the old.

Inactivate the Old Feature

1. Select the polygon, copy the NWI Key, open
the attribute table and make the following
changes:
e Status = Inactive
e Conversion_Type = NULL
e Partial = YES

2. Copy the NWI Key to the clipboard.

Create the New Feature
3. On the Editor toolbar, set the task to ‘Create
New Feature’.
4. Digitize the area around the new, wetland.
5. In the Attribute window, paste the NWI key from the previous polygon into the new
S . —— polygon’s Parent
Key field.

6. Enter the habitat
classification for the
new feature in the
Attribute field. In the
example, the new
wetland has been
classified as a
Palustrine
Unconsolidated
Bottom, Permanently

g,

Atribute:
NWI Key: ==
Parent Key: W
St fae 3
e
Paia —
Field Verifiad: ,ﬁ

[Tioses Flooded and
Excavated, indicated
by a code of PUBHX.
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Converting a Feature (Full)

Interpretation

A fully converted polygon is a wetland that no longer has evidence of existence. These polygons
have been altered due to Agriculture, Development or Recreation. In cases in which none of these
reasons apply, a feature can be assigned a
Conversion Type of Other.

Inactivate the Feature
1. Select the converted polygon and open the
Attribute Table
2. Change the following Attributes:
e Status = Inactive
e Conversion_Type = Agriculture
e Partial = NO
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Converting a Feature (Partial)
Interpretation

The wetland represented by the
polygon in the following image

has

agricultural use. The polygon
needs to be altered to indicate that

the

lies within the forested area.

been partially converted to

only remaining active portion

PS51/EMB

Copy the Feature

1. Select the PSS1/EMB polygon and copy it to the clipboard.

2. Paste the copied feature into the view. This results in a copy of the original polygon in the
same place as the original. The original polygon is automatically inactivated. The new
feature is assigned a parent key of the old feature and is selected for further editing.

i a

=3 Tona\agv Tasks

ut Polygon Featur
-/ Create Tasks

| ‘ Target: [WET_POLY : ACTIVE

Ol-\'qu’&l%

reate New Feature
ks

Modlfy Edge

E
e

ealures.

WET_POLY )
[ PSsifEM | Attribute: PSS1/EMB -

NWI Key: 14086920

Parent Key:

|

Status: Active A

Drainange Type: ,—;[
Patial [ =l
Field Veriied: 4

Comments:
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Reshape the New Feature

3. On the Editor toolbar, set
the task to ‘Cut Polygon
Features’. Cut the copied
polygon along the
boundary of the current
and former wetland. In
the example, the feature
is cut along the treeline.
Be sure to begin and end
the cut outside of the

polygon.



Complete Conversion

4. After completing the cut operation,
three polygons remain: the original
polygon and two new polygons.
Select the original polygon and
make certain the Status = Inactive.
Set the appropriate ‘ ; <
Conversion_Type, and set the A PSSIEME
Partial = Yes. i 3

5. Select the new polygon which
represents the current wetland
extent. Confirm that the Parent e e
Key of this new, active polygon Lyt 2 GSNED
matches the NWI Key from the AR :
original, inactive) polygon.

6. Delete the remnant polygon,
representing the converted area.
This leaves two remaining
features: the original, inactive
polygon and the new, active one.

= WET_FoLY M : :
 Pssijem | Alibute: PSS1/EMB - CorET
B PSSUEM | N1 Key: [140889m R
Parent Key: W |
Status: Active -
Diainange Type: Iﬁ
Partial: I—L|
Field Verified: ]—Ll

Comments:

E
&

g
£
g
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Correcting a Feature

Interpretation

Due to digitizing or georeferencing error, some polygon features do not accurately represent the
wetlands from which they were created. If a polygon is clearly meant to cover a wetland area which
it currently does not, the polygon should be shifted or otherwise edited to accurately represent the
corresponding wetland. In such cases, it is interpreted that the original feature is being corrected.
Therefore, no attribute changes shall be made.

Shifting the Feature
1. Click on the polygon to highlight it.
2. Drag the polygon over the wetland.

Correcting the Feature
1. Double-click on the polygon within it to view its vertices.
2. Holding the cursor over a vertex will produce a diamond shape around the vertex. When this
appears, one can safely move the vertex without shifting the entire polygon. Continue
moving vertices until the polygon accurately portrays the wetland.

(Sometimes using the “reshape feature” task is faster and easier then moving the vertex.)
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Changing the Habitat Classification

Interpretation

Sometimes, wetlands evolve from one type to another. In such cases, the Attribute value must be
changed to indicate an alteration from one habitat classification to another. In the 2003 summer
imagery shown below, there is a polygon labeled PFO5F, indicating Palustrine Forested, Dead,
Semipermanently Flooded.

In the 2005 spring infrared image shown below, we see that the same farm is now being developed.
The wetland area is still there, but the trees have been removed, so the Forested designation no
longer applies.

Copy the Feature
1. Select the polygon, then Copy and Paste it. This action will set the Status = Inactive for the
original. Manually set the following values:
e Conversion_Type = NULL
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e Partial = NO.
2. Copy the NWI Key from the original feature and paste it into the Parent Key field for the

new polygon.

Update the Habitat Classification
3. Change the Attribute to a more appropriate value. In the example, the feature is defined as a
Palustrine Unconsolidated Bottom, Intermittently Flooded, Excavated, orPUBGX.
4. The resulting image shows both Attribute values labeled over the wetland area, as well as
the orange hashes indicating the inactive parcel. The copied polygon is still active.
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Using the attribute transfer tool

The Attribute Transfer Tool is useful in situations in which a polygon is attributed correctly, but is
spatially incorrect. Here is a PUBG polygon that has expanded in the aerial imagery. This wetland
must be digitized again to show its correct boundary, as well as the attributes will have to be
transferred as this polygon will replace the incorrectly-sized polygon.

'.;t-h

~x ‘2 OB
% r_r,. fi
ey _
*fﬂi il

1. Create a new polygon outlining the correct boundary of the wetland.

| weT_poy ]

attribtes —— =
EWET POLY | Attributes Global Variables

4113860

Atibute: |
Nl Key, [osse
Parent Key: I—
Status: IAclive -
Conversion Type:

| j'
Partial Iﬁ
Field Verified: I =
Image Date: [ ¥
Inactive Date: ;

Comments:

=i
H
4 I r
1 features
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2. Open the Attribute Transfer Mapping toolbox. In the toolbox, select WET_POLY for the both the
Source layer and the Target layer. Then click on the “Auto Match’ button (but DO NOT check the
Transfer Geometry) and click OK. This step will only need to be done once for each county being
worked on.

| \:\.‘-ETU_; attribute Transfer Mapping 3 _ﬂéll g
LT, Taiget Lager } 23
[=1-WE” 5
ET_POL |WET_POLY =1
SHAFE_Length
SHAPE Area
A Auto Match
~ Matched Fields
[&TTRIBUTE ATTRIEUTE a]
HGM_CODE HGM_CODE
0AQC_CODE 0AGC_CODE
WETLAND_TYFE WETLAND_TYPE
ACRES ACRES
DECODE DECODE
o1 | ot key Nl KEY i
CE Transfer Geometry Remove I

3. Deselect both polygons and then click on the Attribute Transfer tool. Click within the boundary
of the original polygon (if both polygons overlap, then the “Select a Source Feature” box will
appear. Select the original polygon from the list and click OK). Next, click within the boundary of
the new polygon.

|\:\.‘-;g1:l; Attribute Transfer Mapping i ﬂﬂl ’
ALLby Target Layer i e
ET_POL |WET_POLY =l
SHAPE_Length
SHAPE_Area
Aidd Auto Match
~Matched Fields
ATTRIBUTE ATTRIBUTE =
HGM_CODE HGM_CODE
DAQC_CODE RAQC_CODE i |
WETLAND_TYPE WETLAND_TYPE
ACRES ACRES
DECODE DECODE
1 N KEY MWl KEY =
ool | Transfer Geomely Aemove I
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4. Select both polygons to verify that the Attribute Transfer tool worked properly. If it did, then
delete the original polygon.

|Lay'er | \liertax‘ Edge | End |

[ weT_poy O
atributes |
B-WET_POLY Attibutes Global Yariables
m-pug  Highiight PUBEGx |
Zoom To
: 14154815
Copy

Pa‘ste =4

Unselect 'm
Partial: Mo
Field Verfied I ,
Image D ate: ]1353—
Inactive Date: R

Comments:
=

/|

|2 features |
| |

Here is what the image will look like when this task is completed.

|wer_poLy ] |
0 features
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Special Rules and Considerations

1. If a polygon is determined to be fully converted, it can only be a parent to another wetland if
there is a specified Conversion Type. Otherwise, its NWI Key is never copied and pasted
into a new wetland.

2. Wetland features with invalid habitat classification attributes can be corrected without
further edits being made.

Backups

Ducks Unlimited does not back up individual computers. It is the responsibility of the analysts to
create a zip file of the personal database and map document on at least a daily basis and copy the
zip file to the network drive (W:\GreatLakes_ NWI_Update\Data Backup).

QAQC Procedures

Once the photo interpreter has completed the NWI update for a county, the version will undergo
quality assurance/quality control (QA/QC) before the database administrator posts the version to the
DU MGD. The first QA/QC process involves two steps. The first is to run DU’s 17-step attribute
verification tool that checks for any errors in the additional attributes that were added by DU. The
second step is a topology validation in which it is confirmed that no active features overlap and no
inactive features overlap. The second step in the QA/QC process is for a different interpreter to
visually verify 10% of the county. The third step is to run the USGS NWI attribute and verification
tool (created through a cooperative effort between the U.S. Fish and Wildlife Service and the U.S.
Geological Survey) to check for NWI attribute errors and spatial errors. The counties must pass the
USGS attribute and verification tool in order for the USGS to accept the update back into the USGS
MDG. (For more information on the USGS NWI attribute and verification tool, see
http://capp.water.usgs.gov/FWS_web/tools.htm.) Once the version has completed the QA/QC
process, it will be posted to the DU MGD by the database administrator. This posting process will
update DU’s Master NWI geodatabase and effectively make any and all edits permanent.

During the QA/QC procedure, geodatabases are stored at
W:NWI_Update\GreatLakes NWI_Update\Finished Geodatabases, and status is tracked via the
QAQC Status.xls spreadsheet that is located in that directory.

Self VValidation

DU NWI QA/QC Validations

The data editor runs 17 data validations on the wet_poly dataset as a first step in the QA/QC
process. As previously discussed, the validations were designed by GLARO to assure adherence to
logical and technical rules for the dataset. The validations are listed below:

Test 1: If a feature is inactive and was created prior to 1998, it shouldn't have parent key.
Test 2: The parent key should not equal the nwi key for a single feature.
Test 3: The nwi key cannot be duplicated.
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Test 4: Active features should not have drainage types or partial values.

Test 5: If there is a drainage type, partial should be attributed.

Test 6: If a feature is fully drained, it cannot be a parent to another feature.

Test 7: If partial equals yes and drainage type is null, the parent and child objects must have
different attributes.

Test 8: Inactive date cannot be earlier than or equal to image date, or be null, on inactive
features.

Test 9: If partial equals yes, a feature should be the parent key to an active feature. If partial
equals no and drainage type is null, a feature should be the parent key to an active
feature.

Test 10: If a features is inactive, partial must be attributed.

Test 11: All features should be active or inactive.

Test 12: All features should have an attribute value.

Test 13: A feature's parent key should always be the nwi key on an inactive polygon.

Test 14: The attribute must be valid on active features.

Test 15: Image Date must not be null or 0, and cannot be greater than 1997 for original features
(with few exceptions).

Test 16: Active features cannot have inactive dates.

Test 17: The inactive date on a parent feature cannot be greater than the image date on its child.

First, the operator that worked the county will run a set of tests via ArcToolbox. To install the NWI
QAQC Toolbox, follow these steps:

1. Open ArcMap, show the ArcToolbox window by clicking on the icon: gy

2. Right-click on the ‘ArcToolbox’ header and select ‘Add Toolbox’.

3. Navigate to V:\Installs\GIS Misc\NWI\QAQC Toolbox, select ‘“NWI QAQC Tools’, and
click ‘Open’. This adds the toolbox to your map document.

4. Right-click on the “‘ArcToolbox’ header again and select Save Settings > To Default. Now,
every time you open ArcToolbox, the NWI QAQC Toolbox will be included.

To use the toolbox, you first need to set up your data validation environment. Add the wet_poly
feature class to be validated as well as any relevant imagery and other data. Begin an edit session
before running the validation script.

The validation script can be run two different ways. First, it is executed by double-clicking on the

NWI Validations script in the NWI QAQC Toolbox. Select the wet_poly feature class and the
appropriate test.
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Second, it can be run via the command line. Show the command line window by clicking on the
appropriate icon: £ Run the test by typing “NW!I_Validations” followed by the input feature class
and the test. For example: NWI_Validations WET_POLY 'Test 1'

Run the tests in order, being sure to select the wet_poly feature class from the list of layers in your
map document (A) rather than navigating to the feature class (B).

% NWI Validations

Help |
Input Feature Class
| wWET_POLY ~ g“' Input Feature Class

= NWwl_County
= Nw/I_RefGrid_2000m Input the feature class to be tested.
=

(). I Cancel E nviranments. . << Hide Help

62



document.

feature class from the list of layers in the map

Selecting the wet_
5 NWI Validations.

Help

Input Feature Class

@ Input Feature Class

Test

W to be tested.

Input Feature Class
Lok in: iEil Ml

MWI_County
MWI_ReFGrid_2000m

Marne: IWET_POLY Add
Show of type: | Al filers listed, | Cancel |

|
B) Selecting the wet_poly feature class by navigating to its location on disk.

Each test selects features that fail, but does not automatically refresh the view. To see if any features
were selected, click on the ‘Selection’ tab in the Table of Contents to see how many features in

wet_poly are selected:
Table of Contents X

[T MWIT_Counky
[ MWI_Refarid_2000m
WET_POLY {4)

Dizplay | Source Selectinnl

To view selected features, refresh the view, or use the attribute inspector to zoom to each. The
attribute inspector will automatically list all selected features in its left window pane. You can zoom

to each by right-clicking on the feature label and selecting ‘Zoom To’:
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+ " attribute; |F'EM.-’SS1F j
Highlight
+-PEMF |19 Nyl Key: 11003627
+- PLIBG:: Foom To .
© PEMZ Copy Farent K.ey: |
Stabus: |.-i'-.-:tive j
Unselect Conversion Type: | j
Delete Partial; | j
Field Yerified: | j
Comments:
|4features

Further detail on each test is included in the Help for the NWI Validations script. Access the help by
right-clicking on the script and selecting “Help’, or by clicking on the Help button on the script
dialog window.

Topology

Additionally, no active features should overlap active features and no inactive feature should
overlap inactive features. To validate topology, a topology rule must be created in the personal
geodatabase. Active and inactive overlaps must be tested separately.

Open ArcCatalog, navigate to the personal geodatabase and select the NWI feature dataset.
Right-click and select New > Topology.

Accept the default name and cluster tolerance.

Select the wet_poly feature class to participate in the topology.

Accept the default rank.

Add the rule that active features must not overlap one another. To select active features only,
drop down the feature class combo box and expand the wet_poly feature class.

7. Finish the wizard and validate the entire topology.

oo wdE

To view and edit topology errors:
8. Open ArcMap. Add the topology rule and associated feature class.
9. Add the Topology toolbar to the map document.
10. Start editing the wet_poly personal geodatabase feature class
11. Use the error inspector and topology validation tools to correct and track errors.

Once complete, the topology rule must be changed to validate inactive rather than active features.
To do so, close out of ArcMap and return to ArcCatalog. Edit the topology created earlier, removing
the previous rule and replacing it with one for inactive features. VValidate and correct errors as
before.

Cross Validation

A different data editor is asked to review 10% of the completed counties updates as the second stage
in the QA/QC process. This is done by randomly selecting 10% of the 2000 meter grid cells that
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intersect the county. Do so by adding the NWI_RefGrid_2000m feature class from the personal
geodatabase. Manually select 10 percent of the grid features, and export to a ‘QAQC’ feature class
in the same geodatabase. (This preserves a record of the area that was checked.) Visually inspect all
selected grid cells. If the reviewing editor finds an unacceptable amount of errors, the county is sent
back to the original editor for revision and the QA/QC process begins anew.

Administrator Validation

As the third and final step in the QA/QC process, a data administrator reviews the county’s NWI
update. The data is spot checked at the beginning of the process and visual inspections continue
throughout the final stage of QA/QC. After the initial spot check, the FWS’ attribute validation tool
is run. Once any errors found by the FWS’ tool are corrected, DU’s 16 validations are rerun. If any
errors are found, they are corrected. All of the steps are repeated until both sets of validations find
no errors. The final step is to revalidate topology.

Checking In Data

Upon completion of QA/QC process for each county, the data must be checked back into the
database.

Check In Edits

1. Open ArcMap, add the wet_poly personal geodatabase feature class.

2. Click “Check In’ on the Disconnected Editing toolbar. Leave ‘Reconcile and Post with
parent version’ unchecked and click ‘Finish’. Access the SDE feature class as the user which
checked out the edits. Connect to the version that is checked out (Although any version can
be used at this point, it will be important in the next step that you connect to the checked-out
version, so it is best to establish that connection now.) This will allow ArcMap to unregister
the checkout after checking in the data.

Reconcile and Post Edits

3. Add the wet_poly feature class from the SDE database. Connect as the user that checked out
the edits to the version that is being checked in.

Start editing the SDE workspace.

Click on the “‘Reconcile’ button on the Versioning toolbar.

Reconcile against the sde. DEFAULT version.

Click on the “Post’ button on the Versioning toolbar to post the edits to the sde. DEFAULT
version.

No ok

Update NWI Status layer

Once the update NWI county is reconciled and posted to the SDE databse, the Analyst updates the
NWI status layer for that county to “Complete”. This information then gets posted to the web site
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for the cooperators to view. At this stage the county has been updated, but still needs to go through
the field verification step in order to be “Final”.

Post Completed Counties on Web Site

The completed counties will be posted on the DU NWI web site in shapefile format. This allows
the cooperators to use the draft data and provide feedback before the update is finalized.
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Chapter 7 - Field Verification and Assessment
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The field verification will serve two purposes: 1) to help clarify any wetlands that are ambiguous in
the photo-interpretation process, and 2) to access the accuracy of the NWI update. Field staff from
project cooperators and DU will be used for this process as available.

Ambiguous Wetlands

During the interpretation process, there will be some wetlands that can’t be positively identified by
wetland type or determine if it still exists from the digital orthophotography. In these cases, the
wetlands will be flagged in the NWI geodatabase and a map will be made for field inspection. The
maps will be sent to the field staff for field inspection to determine their wetland type and status.
Once determined, the NWI geodatabase will be updated with the field verification information and
noted in the attributes that the wetland was field verified.

NWI Assessment

The NWI assessment will primarily be an assessment of the wetland status and class. It will not be
an assessment of the full NWI classification scheme (subclass and modifier level). Funding to
perform a full accuracy assessment of the wetland types is cost prohibitive for this project. The goal
of the field assessment is to sample 1% of the wetlands per county and assessing the status and
wetland class through a simple field card and digital photo. DU does not have enough field staff to
visit all of the sites, so a database of field staff from DU cooperators and volunteers for the Great
Lakes will be generated that includes the geographic area each field staff is willing to visit. Once
the field samples are selected, they will be sent to the field staff in the representative areas for field
verification.

The 1% sample will be stratified based on wetland class and status. Only wetlands close to roads or
on public land will be chosen. Once the samples are generated, a field inspection will be conducted
by driving to each site, recording the wetland type, and taking a digital photo of the wetland. The
methods for the field inspection will be patterned off of Ohio NRCS’s field inspection of wetlands
in 2006. The resulting field data and photo will be entered into the DU MGD. An error matrix and
Kappa statistic (Story and Congalton, 1986) will then be compiled and analyzed by comparing the
photo interpretation to the field conditions.

Field Verification Goal

Following updates to the National Wetlands Inventory (NWI), Ducks Unlimited’s Great
Lakes/Atlantic Regional Office (GLARO) will conduct an accuracy assessment of the inventory’s
wetland classifications. The assessment will (1) evaluate the accuracy of classifications assigned to
wetlands original to the NWI, (2) evaluate the accuracy of classifications assigned to wetlands new
to the NWI and (3) evaluate the accuracy of wetlands identified as converted. 1% of wetlands
within the updated NWI1 will be field verified.
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Field Verification Process

Participants

GLARO will contact cooperating partners and volunteers to identify those willing to assist GLARO
in field verification. Typically, participants will be familiar with wetland classifications. GLARO
will then match participants with wetlands within areas that they may conveniently visit.

Field Verification Materials

Each participant will be provided with: a set of directions, maps of the wetlands to be field verified,
and a photographic guide to wetland classification. GLARO will also provide disposable digital
cameras to participants who require them.

What is asked of participants?

Participants will be instructed through provided directions to visually inspect each wetland, assign a
wetland classification and then take a photograph. The participants will then be instructed to return
all field verification materials to GLARO.

Wetland Selections

Percentage Goal

GLARQO intends for 1% of all wetlands within a county to be field verified. As a variety of
problems may prevent the successful verification of a wetland, a surplus of wetland selections will
ensure that this goal is met. 2% of wetlands will therefore be selected for field verification. The
entirety of this 2% selection will be given to project participants with the intention of at least 1%
visited in the field.

Grouped Selections

As previously stated, this assessment intends to (1) evaluate the accuracy of classifications assigned
to wetlands original to the NWI, (2) evaluate the accuracy of classifications assigned to wetlands
new to the NWI and (3) evaluate the accuracy of wetlands identified as converted. Wetlands,
therefore, will be separated into three groups to select wetlands for field verification. The groups
are:

1. Wetlands original to the NWI. This includes wetlands unaltered by updates and also
wetlands that had been included in the original NWI that have been modified.

2. Wetlands new to the NWI. This includes only wetlands not associated with any wetland
included in the original NWI.

3. Wetlands identified by the updated NWI as converted.

Class Selections

To ensure that wetlands selected for field verification are representative of the actual population of
wetlands, wetlands will be selected from the above groups stratified by classification type. To
clarify, within each group of wetlands, subgroups designated by classification type will be identified
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and then selections made from each subgroup. Note, however, that the assessment will recognize
only differences in classification according to class level, not subclass or modifiers.

Limited Selection

The assessment recognizes that it is not realistic to expect, or even request permission to inspect
wetlands on private property. To accommodate this restriction, only wetlands within 90 meters of a
roadway (approximately the distance of one football field) will be selected for verification.

NWI Status Layer

Before the analyst begins the wetland selection process, the “verified” attribute is changed to “In
Progress” in the NWI status layer. This allows the manager and staff to identify which counties
have started the wetland selection process for field verification.

Edtor> B9 | h M| % Checkout Sslection <1 % B &% () = © Task: [CreateMewFeature ¥ | Target: [vector GLAROGIS Statu >
I
P

[~ & Layers |
= B vector.GLAROGIS. Status /

e -+ Change NWI
By

M Completed
. Final

status layer from
: é Null to In

= vector. GLAROGIS. Status Property | value !

+ Augiaize | OBJECTID 115
NAME Auglaize
| STATE_NAME Ohio
|STATE_FIPS 39
CNTY_FIPS D11
|FIPS. 39011

| STATUS Completed
| VERIFIED |In Progress |
| Spea
| Shape.Jen In Progress

1features

Display [ Sourca | Selacbon] |e 02wy

Wetland Selection Methodology

To select wetlands according to the above specifications, a GIS-based methodology has been
developed. This process is performed on a per-county basis. The methodology is outlined below:

1. Navigate to the Field Verification Tool installation package located at V:\Installs\GIS
Misc\NWI\Field Verification Selection\Package\setup.exe. Complete the installation
process. This step only needs to be done once so if you have already completed the
installation please move on to step 2.

2. If one does not already exist, create a folder in your D:\Working folder named ‘Field
Verification’

3. In ArcCatalog, create a new personal geodatabase in your Field Verification folder
named Countyname_Stateabbreviation_FV (i.e. Huron_OH_FV).

4. Inthat new PGD, create a new polygon featureclass named FIELD VERIFICATION.
Import the coordinate system and the schema from the SDE WET_POLY layer.
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5. Open arcMap and add the SDE WET_POLY and NWI_COUNTY layers to the new map
document.

6. If you have already installed the FVSelect.dll, please continue to step 7. Otherwise,
Navigate to Tools > Customize > Commands > Add from File and add the FVSelect.dll
from the folder C:\Program Files\FVSelect.

7. Navigate to the NWI category in the Categories Window and from the Commands
window drag both the “Select NWI’ and ‘Field Verification Selection’ buttons to the
toolbar.

8. Click on the ‘Select NWI’ button and choose the state and county of interest, then click
on the “Select’ button.

9. Extract (do not check out) the selected features to your County’s PGD and choose to
change the layers and table to point to the extracted data.

10. Add the SDE GrtLks_All_Roads layer to the map document. Select by location all roads
intersecting your county and export as a feature class in the same projection as the data
frame into your County’s PGD. This feature class should be named “GrtLks_All_Roads’.
Add to map document. Remove the SDE GrtLks_All_Roads layer from the map
document.

11. Add the Vector. GLAROGIS.PARENT TABLE from the vector database on SDE to the
map document as well as the new FIELD_VERIFICATION layer from your PGD.

12. Make sure the following are true:

a. These feature classes must be present and have these specific names in the TOC:
i. WET_POLY
ii. GrtLks_All_Roads
iii. NWI_COUNTY
iv. FIELD_VERIFICATION
b. The parent table must be in the map document and must be the only table in the
map document
c. There must not be any raster layers in the map document

13. Begin an edit session with the FIELD_VERIFICATION layer as the current editable
layer.

14. Click the “Field Verification Selection’ button to start the selection process.

15. Once the selection is completed, save edits and stop editing session.

16. Backup your County’s PGD to the appropriates State’s folder in
W:\GreatLakes NWI_Update\Field_Verify

Creating Field Verification Maps

Create Overview Map of County

1. Make sure before you begin that the MapBook is installed on your computer. It will appear
as a tab on the Table of Contents in ArcMap. If not, navigate to V:\Installs\GIS
Misc\extensions\DS_MapBook\DS Map Book v2 Edited\ install.bat to install a customized
version of the extension.

2. If you haven’t already, copy the ‘Field_Verification_OverviewMapbook_Template.mxd’
and ‘Field_Verification_Mapbook Template.mxd’ files from
W:\GreatLakesNWI_Update\Field_Verify into your FIELD_VERIFICATION folder on
your D:/ Drive.
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Create a new polygon shapefile named “Overview Grid” saved to your D Drive that will be
used to divide the County into 4 parts. Add a text field named “Index”. This shapefile can
be reused and is just for cartographic purposes so this step only needs to be done the first
time you complete this process.

Open ‘Field_Verification_OverviewMapbook _Template.mxd” and view the data source
properties for the FIELD_VERIFICATION featureclass. Reset the source to the

FIELD VERIFICATION feature class for the County you are printing field maps for.
Zoom to this layer.

Symbolize the vector. GLAROGIS.NWI_County featureclass by the County of interest with
a White background and All Other Values gray.

Reset the data source to the Overview Grid shapefile that you created in step 3. Start an
editing session on this shapefile and delete all features in the shapefile. Create a square
around the County of interest and then cut this square into 4 quadrants and fill in the text
field you created for the shapefile with the number of the quadrant.

Update Title with appropriate County name and placement.

Print the map.

Label the FIELD_VERIFICATION feature class by the NWI_KEY field.

. Click the ‘Map Book’ tab in the TOC and right-click ‘Map Series’ and delete series if one

exists already. Right-click ‘Map Book’ and choose ‘Add Map Series’.
a. Set up the first screen like below. Click ‘Next’

Map Sheet Wizard X

The Map Series uzes one of the data frames in the layout az the Detail Data Frame. This data
iz shown at a different extent on each page. The extents aor tiles are defined by ane of the
polygon lavers in the data frame.

Choose the detail data frame: Index Layer
Layers j Chooze the index layer:
| OwerviewEnd ﬂ
Thiz field zpecifies the page name
.
Mext » Cancel
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b. Set up the second screen like below. Click ‘Next’
Map Sheet Wizard X
By default the Map Series shows a page far each til [polygon] in the Index Layer. v'ou can

reduce the number of pages in you senes by zelecting only certain tiles ar by automatically
eliminating pages that don't contain interesting features.

Chooze files Supprezs files
o Usze all of the tiles v Don't uze emply tles. A tile = emphy
unlezz it contanz data from at least
" one of the fallowing selected layers:

FIELD_VERIFICATION
) verviewianid
b ajor Roadz
vector. GLAROGIS . Hwl_County
countiez24k,_mg

(" Uze the vizible tilez

< Back | Meut » | Cancel |

c. Set up the third screen like below. Click ‘Finish’ _
Map Sheet Wizard X

The Map Series provides several different optionz for fitting a tile ta the data frame.

E stent O ptionz
f« ‘fariable - Fit the tiles to the data frame [ Raotate data uzing value from this field:
M argir ||:| ||:|er|:ent j | J
" Fized - ,u'l‘dwa_lrlg draw at thiz scale: [ EIII:I data to the outline of the tile
1; [
(" Data driven - The scale for each tile iz [ Label neighboring tiles?

zpecified in this index laver field:

¢ Back | _, .................... : Cancel

L.

11. There are now maps for each quadrant you created. Double Click page 1 and change the
title to *“X County Page Y and then print the page. Do this for each page.
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Create the Field Maps

1. Open the Field_Verification_Mapbook_Template.mxd file. Edit the county and state in the
top-right corner of the layout.
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2. Update the TOC for the specific County

a. Start with the ‘Full County View’ data frame. Change the County symbology to
your County of interest. This County should pe White while all other values are
gray. Pan the data frame so it can be seen oan tweak the scale so you can
see the entire County.

b. Change the ‘Scaled Local Identifier’ data frame next. For the GrtLks_All_Roads
feature class, set the data source to the GrtLks_All_Roads featureclass from your
PGD for the County of interest. Also for the vector. GLAROGIS.NWI_County
feature class change the symbology to your County of interest with the same beige
color and all other values gray. Note: This data frame should stay at the scale
1:120,000.

c. Finally, change the Wetlands Features (1:6000) data frame. For the
GrtLks_All_Roads, FIELD_VERIFICATION, and NWI_County feature classes set
the data sources to the data from your PGD for the county of interest following the
same procedure seen in the above step. Pan to your County. Note: This data frame
should stay at the scale 1:6,000.

d. Inthe top right corner of the map, change the name of the County to your County of
interest.
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3. Click the Map Book Tab in the TOC. Right-click ‘Map Series’ and Delete Series if one
exists. Right-Click ‘Map Book’ and select *‘Add Map Series.’
a. Set up first Screen just like the one below. Click ‘Next’ _

The Map Senes uzes one of the data framesz in the lavout az the Detail Data Frame. This data
iz shown at a different extent on each page. The estentz or tilez are defined by one of the
palvgon layers in the data frame.

Choose the detail data frame: Index Layer
‘Wetland Features [1:6000] | Choaze the index laer:
\FIELD_VERIFICATION |

Thiz field zpecifiez the page name

| M et > | Cancel |

b. Set up the second screen just like the one below. Click ‘Next’
Map Sheet Wizard [
By default the Map Senies shows a page for each bl [palygon] in the Index Laver. You can

A reduce the number of pages in vou zeres by selecting only certain tiles or by automatically
eliminating pages that don't contain interesting features.

Chooze files Suppress files
f+ Uze all of the tiles [vw Dan't use emphy tiles. A tile iz empty
unless It contains data trom at least
"~ one of the following selected lapers:

Grilkz_aAl_Roads
MIFIELD YERIFICATION
M l_County

" Usze the vizible tiles

< Back et = Cancel
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c. Set up the third screen just like the one below. Click ‘Finish’
» | |

The Map Senes provides sewveral different options for fithing a tile to the data frame.

E stent Optians
" “anable - Fit the tiles to the data frame [ Rotate data uzing value fram this field;
b argin | | J | J
(* Fised - Always draw at this scale; [ Clip data to the outling of the tile
1:|E000 r

" Data drven - The zcale for each hle is [ Label neighboring tiles?

zpecified in thiz index layer figld:

< Back | Firish | Cancel

d. The map book is now all set up and ready. Double-click on page 1
4. There are Extent Windows set up in the Full County View and Local Identifier Data Frames
based on the Wetlands View (1:6000) data frame. The one in the Full County View data
frame will appear as a red dot somewhere in the County. For the Local Identifier data
frame, you will need to pan around the county to find the red square extent window. Make
sure to have this centered for each map.
5. You will need to do these last 2 steps manually for each map.

a. Note: If there are more than 1 wetland in the Wetlands View (1:6000) data frame,
create a callout graphic pointing to the wetland(s) that is not the primary focus of that
map.

b. Note: Sometimes a wetland is too large to fit fully in the Wetlands View (1:6000)
data frame at the 1:6000 scale. If this is the case, right-click ‘Map Series’ and select
‘Series Properties. Change the Extent to Variable with a 5% margin and click
‘Finish’. You will have to refresh the current page you were working on for this to
take effect. Make sure however that after you are finished with that current page, to
go back to the “Series Properties’ to change the extent back to Fixed at 1:6000.

6. After the first map is complete right-click the page you are on and click ‘Print Page’.
7. Double-click on the next map and follow steps 4-6 until you finish all maps.

Field Verification

Once the field verification maps are created they need to be sent to cooperators or visited by DU
staff. This project does not have a lot of time budgeted to perform the field verification; therefore
most of the field verification will be performed by cooperators or volunteers.

Cooperator Database

In order to keep track of the cooperators and volunteers for the field verification, a database was
created that keeps track of the name and address of the individuals along with the county and map
numbers that were sent. Once the field verification maps are created for a county, the cooperator
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database is queried to determine the number of individuals available for field verification. The
maps are then split up between the individuals and sent along with instructions (Appendix D). The
cooperator database is located at W:\GreatLakes NWI_Update\Field_Verify\ Field Verification
Contacts.mdb.

B contacts gg‘

First Name [Tom City Columbus

Last Mame [Araour State OH |

Title [EcologistGls | ZipCode 43229

Organization |ODNE Division of Matural Areas and Preserves | Phone _61'4'—2'65':64'?2

Address 2045 Marse Foad. Bldg. F-1 Ehail Tom Arbour@dnr, state.oh.us
Address 2 Fax 614-267-3096

MNotes:

May be able to do werification anywhere within the Lake Erie watershed of Ohio

P State: [Ohio | County. [allen v | Zent [1120 Recaived: [11-20 A
[ State: Oh\u v | County: [Ashland v | Sent [21-40 Receivad: [21-40
[ ] State: [Ohio < County Cuyah'og'é' _v. Sent [21-40 Received: [21-40
[ State: :Ohm v County. [Hardin v: Sent: |1-20 Received: [1-20
[ State: _Ohm v County: |Henry | Sent |11-20 Received: [11-20
[ ] State: :dﬁwb v | County _Hﬁron I~ Sent [11-20 Recehed: _Iﬁ:EID
[ State: |Ohio ~ | County: |Lorain v Sent: 521730 Received: 21-30
[ ] State: _Ohm v | County 'Pau\dlng | Sent: |16-30 Recered: 16-30
[ ] State: _Oh\o w | County: [Putnam w [ Sent [17-20 Recemed: 11-20
[ ] st [ohio v | County _\I/én.Wer.t v | Sent [11-20 Received: 11-20
L L L 7
[#] Thank ‘vou

Record: E[Z] ’—11 E]m[m of 69

Field Verification Assessment and Updates

Once the field maps have been verified in the field and returned to Ducks Unlimited, they need to
be entered into the NWI Photos geodatabase, compared to the updated NWI data, and make any
corrections to the updated NWI.

Check out NWI Data and Add Verification Layers

1) In ArcCatalog, create a new Personal GeoDatabase on your working drive using the
County_State AA_date (ex: Jackson_MI_AA 06 20 _08) naming convention.
2) Follow the NWI check out procedures
3) Add the NWI_Photos SDE layer in the NWI_Other GeoDatabase to your map document and
change version.
a. Click on Source tab on the bottom of the ArcMap Table of Contents
b. Right Click on sde.Default (glaro_sde) and go to “change version”
c. Change the version to “NWI_Photos”
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4) Add NWI Field Verification table (Make sure this table is from the NWI_Phtotos version as
well, if not, change it like in step 3.

Add Field Verification Point and add attributes

For pre-selected sites:

1) Use the Find tool (Edit > Find), Features tab to find and zoom to the Wetland # of the pre-
selected site that was field verified.

2) Start Editing the NWI_Photos layer and create a point that corresponds to the location of the
photo drawn on the field verification map.

3) Add attributes from field verification form to the attribute table.

4) Add digital photo to the raster attribute, click on the attribute and navigate to the photo.

For field selected sites:

1) For field selected sites already in shapefile (OH NRCS), add the shapefile and “copy” and
“paste” the points into the NWI_Photos layer. Make sure all of the attributes are copied into
the NWI_Photos Layer.

2) For field selected sites without a shapefile, locate the location based on the Lat/long or
intersections and aerial photos and add the point like in the pre-selected site.

Update NWI Field Verification Table

1) Add the county, state, NWI Key, NWI code (from the NWI polygon), Field code (from the
field data sheet, and the preseleted field.

2) Be sure to look at the field photo and double check that the NWI class from the field
verification makes sense. For the NWI codes, only go to the CLASS level (PUB, PEM,
PAB, PFO, PSS, LUB), as we are not verifying the subclasses or modifiers.

3) For the converted wetlands — Identify them in the Field Verification Table as: CA =
Converted due to Agriculture, CD = Converted due to Development, CR = Converted
due to Recreation, CO = Converted due to Other.

Update the NWI data

1) Update the NWI code in the NWI polygon layer if the class was different from the field
verification.

2) Update the NWI polygon shape if necessary

3) Make sure to change the Field Verification attribute to “YES”.

Final QA/QC and check into SDE

1) Run the QA/QC process on the NWI county data and then send to Analyst to check back
into the SDE layer.
2) Change the NWI status layer to Finished.
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3) Notify Blair to reconcile and post NWI Photos version (specifically mention NWI_Photos
featureclass and FIELD_VERIFICATION table) to the default version.

Create Accuracy Assessment Table

1. Create an ODBC Connection to the SQL Server Database for your computer if not already
created. If one is already created, proceed to step 2.
a. From the Control Panel, open Administrative Tools and then Data Sources (ODBC).
b. The ODBC Data Source Administrator Window opens. On the System DSN tab and
click *‘Add’
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1 ODBC Data Source Administrator,

zer DSH - System DSN l File D'SH ] Drivers] Trau:ing] Cannection F'DDIing] Ahaout ]

Sysztem Data Sources:

Marne | Driver | dd
SOL Server

Remove

LCanfigure...

i

&n ODEC System data zource stores information about how to connect to
the indicated data provider. A Sypstemn data zource iz vizible to all users
on thiz machinge, including MT services.

(] 4 | Cancel | | Help ‘

c. Scroll down the list on the Create New Data Source Window and select SQL
SERVER and click “Finish’

Create Mew Data Source &l

Select a drver for which you want to set up a data source.

M ame | WA
Microsoft FoxProFP Driver [*.dbf)
Micrazaft DDBC for Oracle
Microzoft Parados Driver [*.db ]
Microzoft Paradox-Treiber [*.db ]
Microsoft Test Diriver [*.tat; * o)
Microzoft Test-Treiber [*.tut; * cav]
Microsoft Wisual FosPro Driver
Microsoft Wisual FoxPro-Treiber
SOL Server

£

i e R S R A R S ]

W

| Finizh | Cancel

d. On Create a New Data Source to SQL Server screen, name the data source ‘vector’
and describe it as ‘vector’. In the Server drop down menu, choose ‘GLARO_SDE’.
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Click “‘Next’

Create a Mew Data Source to SQL Server ['5—<|

Thiz wizard will help pou create an ODBC data source that pou can uze to
connect to SOL Server.

Ww'hat name do pou want to use to refer to the data zource?

M arne: |"-.fect|:|r.sde

Haow do pou want to dezcribe the data source?

Description: |'-.,.fe.3t|:.r

‘Whhich SOL Server do vou want to connect ba?

S G ARD SDE ﬂ

Finizh | Mext > | Cancel | Help

On the Microsoft SQL Server DSN Configuration screen, select the second radio
button as seen below and make sure the ‘Connect to SQL Server.....” box is checked.
For Login ID enter your user name and for password enter your SDE Password.
Note: This is different than your Windows authentication password you login to
Windows with. Click ‘Next’

Microsoft SOL Server DSN Configuration r5_(|

How ghould SOL Server venfy the authenticity of the login 1D

O With "Windows MT authentication uzing the network; login 10,

o With SOL Server authentication uzing a login |0 and passward
entered by the uger,

To change the netwark library uzed to communicate with SGL Server,
chck Client Configuration.

Client Configuration...

Connect ta SOL Server to obtain default zettings for the
additional configuration options.

Lagin [D: |astryker

EERETT

Pazzwaord:

< Back | MHext > | Caricel Help
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[ Change the default databaze to:

| [

[ Attach databasze filename:

v UzeAMS| quated identifiers.
v Use AMS| Aullz, paddings and warmings.

-

< Back | Mext > | Cancel Help |

Leave everything on the next screen the same and Click ‘Finish’
Microsoft SQL Server DSN Configuration

[~ Change the language of SGL Server spstem messages to;

| [

I Use strong encryption for data

[v Perfarm tranzlation for character data

r IJze regional zettings when outputting currency, numbers, dates and
timesz.

[~ Sawe long running queries to the log file:

Long query time [milizeconds]; |

[ Log ODBC driver statistics ta the log file:

| _Bows=.. |
¢ Back | Finizh | Cancel | Help |
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2.

h. Click “Test Data Source’ and if successful, Click ‘OK’. If unsuccessful, go back and

double check all settings are correct.

ODBC Microsoft SQL Server Setup

3

& new ODBC data zource will be created with the follawing

configuration:

Microzoft SOL Server ODBC Driver Werzion 03851132

Data Source Mame: vector. zde

Data Source Description: vector. sde

Semer GLARD_SDE

D atabaze: [Default]

Language: [Default)

Tranzlate Character Data: Yes

Log Long Running Queriesz: Mo

Log Drriver Statistics: Mo

I1ze Integrated Security: Na

|lze Regional Settingz: Mo

Frepared Statements Option: Drop temparary procedures on
digconnect

Ilze Failover Server Mo

ze AMS| Quated |dentifiers: Yes

ze ARSI Mull, Paddings and */ arnings: v'es
Data Encryption: Mo

Test Data Source. .. | ] | Cancel |

If you have not done so already, copy the ‘Accuracy Assessment Matrix.rpt” file from
W:\GreatLakes NWI_Update\Field_Verify onto your D Drive. This is a Crystal Reports file
which requires that Crystal Reports be installed on your computer. If you have not already
done so, install Crystal Reports for ESRI from the ArcGIS media.

Open the “Accuracy Assessment Matrix.rpt’ file. If it is not already in the Preview mode,
click on the “Preview’ tab on the left side of the window.

I Crystal Reports for I5K - | Accuracy Assossment Matrix rpf]
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To view the data for a particular county, click on the Refresh button =2 on the toolbar. If
you are asked if you want to Refresh Report Data, select ‘Prompt for new parameter values
and click ‘OK’.

Refresh Report Data

() Use current parameter values

() Frampt for new parameter values

[ ak. H Cancel H Help ]

Enter a state and county from the dialog and click ‘OK’.

Before continuing, ensure that all wetlands have been properly classified. For the purposes
of field verification, we are only classifying to the Class level, meaning that the only valid
entries for NWI Code or Field Code in the field verification table are CA, CD, CR, PAB,
PEM, PFO, PSS, PUB, and LUB. Any features that have an invalid NWI Code or Field
Code will be tallied in red text as an “Incorrectly Classified Wetlands’ notation in the
bottom-right corner of the report. Correct these entries are refresh the report. If the notation
does not appear, all wetlands have been classified correctly.

From the File menu, select Export > Export Report. Select format ‘Adobe Acrobat (PDF)’
and click ‘OK”.

Name the file “County_State AATable_Date” i.e.”Jackson_MI_AATable 06182008 and
save in the appropriate State’s folder in W:\GreatLakes NWI_Update\Field_Verify.
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Chapter 8 — Integration with FWS NWI
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This project will result in the creation of two NWI products. All products will be in Albers Equal
Area projection as used by the FWS in the NWI MDG. The first product is the DU MGD that will
be used to track the status of wetlands across Indiana. Since no additional attributes can be added to
the FWS MGD, another product will be created that will be sent to the FWS for inclusion into the
NWI MGD. Therefore, all additional fields in DU’s MGD will be removed before the layer is sent
to the FWS. In order to accomplish this, another version of DU MGD will be created which will
have all records of converted wetlands and DU added fields removed.

Upon completion of a 1:100,000 USGS quad cell, the features within the cell are extracted and
delivered to the FWS, where they are merged back into the master geodatabase. Active features
only are returned to the FWS.
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Chapter 9 - Reporting
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The reporting for the NWI update is based on a state-wide analysis and county by county analysis
using the full DU updated NWI dataset. The dataset sent to the FWS for inclusion in the official
NWI data can not be used for comparison between the original and updates NWI (see Chapter 8 for
more details). Both wetland numbers and wetland acres were determined and compared between
the original NWI (1980-1988) and the updated NWI (2005). The wetland numbers and acres were
generated using the status, conversion type, image date and parent key. This chapter will explain
the process for calculating the number and acres using the additional attribute fields.

It is important to note that wetlands identified in the update that were not in the original, are
not necessarily newly created wetlands. In many cases, the scale of the imagery used in the
update (2005) was better than what was used in the original classification. Therefore, many of

the newly identified wetlands are small and would not necessarily have been seen in the
original classification.

Also note that summing the number of wetlands from the county analysis will not equal the

state-wide number because the wetlands that overlap county boundaries will be double
counted.

Data Organization and Pre-processing

Below are the data organization and pre-processing steps that need to be performed on the data
before calculating the wetland numbers and acres. Some of the layers below refer to data layer
names specific to the Ducks Unlimited system, but you can substitute your own county layer or
other boundary layer. In summary, the below process extracts the wetlands for a given state from
the Great Lakes NWI wetlands geodatabase and adds the Parent Key attribute to identify those
wetland that were modified (changed class) from those that were converted.

In ArcCatalog, create a new personal Geodatabase called “state_stats” — with “state” being
the name of the state you are summarizing.

Open ArcMap

Add GLAROGIS.USA_County and GLAROGIS.WET_POLY layers

Select by state name in the USA_County layer the state you want to summarize
Select by location all WET_POLY that intersects the selected counties.

Export the selected polygons to the state_stats personal geodatabase and name it
“WET_POLY™.

Add an attribute called “Parent” to the newly created “WET_POLY” layer (Text, 2)
Add the PARENT Table
Join the PARENT Table to the WET_POLY layer.

Select by attribute in the WET_POLY layer where Parent_Key is not NULL
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Calculate the Parent attribute = Y
Switch selection

Calculate the Parent Attribute = N

Original Wetland Numbers and Acres

In order to report wetland numbers from the original NWI classification, a selection of wetlands is
performed where the “Image Date” is from the dates that the original classification was performed.
The original dates can be determined from the FWS NWI metadata. For the state of Indiana the
original classification was performed from imagery between 1980 and 1988. In summary, the
below process selects the wetlands with an image date between 1980 and 1988, intersects it with the
county layer and summarizes the number and acres of wetlands by county.

Select from WET_POLY:

Image Date < 1989

Create layer file from selection

Intersect selection with county, and name WET_POLY_Org_Cnty

Re-calculate the Acres field

Summarize by county name on Acres

Current Wetland Numbers and Acres

In order to report current wetland numbers from the NWI classification, a selection of wetlands is
performed where the Status is Active (0). In summary, the below process selects the wetlands that
are active based on the most current imagery (2005 for Indiana), intersects it with the county layer
and summarizes the number and acres of wetlands by county.

Select from WET_POLY:

Status =0

Create layer file from selection

Intersect selection with county, and name WET_POLY _Act_Cnty

Re-calculate the Acres field

Summarize by county name on Acres

89



Fully Converted Wetland Numbers and Acres

In order to report the wetland numbers that were fully converted (the entire wetland was converted),
a selection of wetlands is performed where the “Status” is “1 - Inactive” and “Partial” is “N” (NO)
and “Conversion Type” is not “Null”. The selection is then intersected with the county layer and
summarized to determine the number and acres of wetlands by county.

Select from WET_POLY:

Status = 1, Conversion type is not NULL, Partial = N

Create layer file from selection.

Intersect with county layer and name WET_POLY_Full_Cnty

Re-calculate the Acres field

Summarize on county by acres.

Partially Converted Wetland Numbers and Acres

In order to report the wetland numbers that were partially converted (only part of the wetland was
converted), a selection of wetlands is performed where the “Status” is “1 - Inactive” and “Partial” is
“Y” (Yes) and “Conversion Type” is not “Null”. The selection is then intersected with the county
layer and summarized to determine the number and acres of wetlands by county.

Select from WET_POLY:

Status = 1, Conversion type is not NULL, Partial =Y

Create layer file from selection.

Intersect with county layer and name WET_POLY _Part_Cnty

Re-calculate Acres field

Select from WET_POLY:

Status = 0 (Active)

Create Layer file from selection and name WET_POLY_Active
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Intersect WET_POLY_Part_Cnty with the WET_Poly active selection and name
WET_POLY_Part_Act.

Dissolve all polygons that have the same NWI Key (Check to make sure you have the same
number of polygons as are in the WET_POLY _Part_Cnty layer), name layer
WET_POLY_Part_Dis.

Caculate the acres for the Child Acres field (the second *“acres” field).
Create new field called “Part_Acres”

Caculate Part_Acres as Acres — Acres_1
This is the number of acres that were converted for the partial wetlands.

Summarize on county by “Part_Acres”.

Additional Wetland Numbers and Acres

In order to report wetland numbers identified in the updated NWI and not in the original NWI
(“new” wetlands), a selection of wetlands is performed where the “Status” is “0 - Active” and
“Image Date” is greater than “2005” and “Parent Key” is “N”.  The selection is then intersected
with the county layer and summarized to determine the number and acres of wetlands by county.

Select from WET_POLY:

Status = 0 and Image Date = 2005 and Parent Key = N

Create layer file from selection.

Intersect with county layer and name WET_POLY_Add_Cnty

Re-calculate the Acres field

Select Attribute for “PW?”, “Pf” and “PEMATf” and switch selection

Summarize on county by acres.
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Chapter 10 - Results
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The results reported in this document are for planning purposes only and are not intended for
regulatory purposes. Before using any of the reported results, the user should have a through
understanding of the methods reported in the previous chapters. Please see Appendix C for a
list of wetland statistics by county.

Wetland Conversion by Number and Acreage

The total number of original NWI wetlands (circa 1980-1988) that were fully or partially converted
(circa 2005) was 36,943 (Table 1). A majority of the wetlands converted were fully converted
(31,952). The total acreage of original NWI wetlands (circa 1980-1988) that were fully or partially
converted (circa 2005) was 45,415.96 (Table 2). The average size of the converted wetlands was
1.23 acres. The majority of the converted wetlands were due to agricultural purposes (72%) with
development being the second largest percentage (24%). The geographic distribution of the
wetland conversion is concentrated in the northern and southwestern parts of the state (Figure 1).
The number of acres converted by county varied from 8 to 2,674 acres.

Table 1. The number of wetlands converted by conversion type (1980-88 to 2005)

AGRICULTURE DEVELOPMENT RECREATION OTHER
Number % Number % Number % Number % TOTAL
FULLY CONVERTED 24,588 76.95% 6,109 19.12% 210 0.66% 1,045 3.27% 31,952
PARTIALLY CONVERTED 2,529 50.67% 1,972 39.51% 144 2.89% 346 6.93% 4,991
TOTAL 27,117.00 73.40% 8,081.00 21.87% 354.00 0.96% 1,391.00 3.77% 36,943

Table 2. The acreage of wetlands converted by conversion type (1980-88 to 2005)

AGRICULTURE DEVELOPMENT RECREATION OTHER
Acres % Acres % Acres % Acres % TOTAL
FULLY CONVERTED 25,023.05 79.20% 5,722.61 18.11% 369.84 1.17% 477.44 151% 31,592.93
PARTIALLY CONVERTED 7,895.24 57.12% 5,090.85 36.83% 527.36 3.82% 309.59 224%  13,823.03
TOTAL 32,918.29 7248%  10,813.45 23.81% 897.19 1.98% 787.03 1.73%  45,415.96
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Figure 1. The number of converted acres from the original classification by county.
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Wetland Conversion by NWI Class

A majority (56%) of the wetlands converted was emergent wetlands, with open water at 25% and
forested at 13% (Table 3). When comparing the wetland classes converted by acreage, the
emergent wetlands still has the highest percentage (48%) but the forested classes is second with
32% of the conversion acres (Table 4). Therefore, the forested wetlands were converted at a lower
rate then the emergent wetlands, but larger areas of forested wetlands were converted when the
conversion happened.

Table 3. The number of wetlands converted by wetland class (1980-88 to 2005)

AQUATIC BED EMERGENT FORESTED SCRUB-SHRUB  OPEN WATER SHORE OTHER

Number % Num ber % Number % Num ber % Number % Number % Number % TOTAL
FULLY CONVERTED 222 1% 19,285 60% 2,336 7% 1,094 3% 8,812  28% 149 0% 54 0% 31,952
PARTIALLY CONVERTED 30 1% 1380 28% 2559  51% 385 8% 607  12% 4 0% 26 1% 4,991
TOTAL 252 1% 20,665 56% 4895  13% 1,479 4% 9419 25% 153 0% 80 0% 36,943

Table 4. The acres of wetlands converted by wetland class (1980-88 to 2005)

AQUATIC BED EMERGENT FORESTED SCRUB-SHRUB OPEN WATER SHORE OTHER

Acres % Acres % Acres % Acres % Acres % Acres % Acres %  TOTAL
FULLY CONVERTED 113 0% 18,392 58% 6,216 20% 2,072 7% 4,294 14% 177 1% 330 1% 31,593
PARTIALLY CONVERTED 20 0% 3,319 24% 8,328 60% 924 7% 489 4% 6 0% 737 5% 13,823
TOTAL 133 0% 21,711 48% 14,543 32% 2,996 7% 4,783 11% 183 0% 1,066 2% 45,416

Wetlands not Included in the Original NWI

It is important to note that wetlands identified in the update that were not in the original, are
not necessarily newly created wetlands. In many cases, the scale of the imagery used in the
update (2005) was better than what was used in the original classification. Therefore, many of
the newly identified wetlands are small and would not necessarily have been seen in the
original classification. The average size of the added wetlands was 1.7 acres, which is below
the minimum size (2-3 acres) of the original NWI mapping scale.

There was a total of 60,346 additional wetlands that were added to the inventory, with a total of
102,486 acres (Table 5). Of the wetlands that were added, 80% were open water, followed by
emergent, forested, aquatic bed, other, and shore. The size of the additional open water wetlands
averaged under an acre and were mostly “backyard ponds”. There was a significant amount of
emergent wetlands added to the inventory with over 26,000 acres added. The spatial distribution of
the added wetlands are displayed in Figure 2 (number) and Figure 3 (acreage).

Table 5. The number and acres of additional wetlands by wetland class

AQUATIC BED EMERGENT FORESTED SCRUB-SHRUB OPEN WATER SHORE OTHER

Acres % Acres % Acres % Acres % Acres % Acres % Acres % TOTAL
ADDITIONAL ACRES 419 0% 26,723 26% 6,450 6% 1,494 1% 43479  42% 0 0% 23922 23% 102,486
ADDITIONAL NUMBER 387 1% 9325 15% 1,677 3% 573 1% 48124 80% 0 0% 260 0% 60,346
AVERAGE SIZE 1.08 2.87 3.85 2.61 0.90 0.00 92.01 1.70
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Figure 2. The number of additional wetlands by county
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Figure 3. The acreage of additional wetlands by county
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Net Wetland Change from 1980/88 to 2005

Please use extreme caution when using these numbers. The reported change in wetlands is a
useful planning tool, however, several factors should be used in conjunction with the reported
numbers. First, as described in the additional wetlands section above, the additional wetlands
may or may not have existed during the original classification due to the scale of the original
imagery. Second, the wetland change does not consider wetland type in the analysis. All
wetlands are not created equal when determining habitat value or function. For instance, a
net gain of 5,00 acres in a county may sound good, but if there was a loss of 10,000 acres of
emergent wetlands and a gain of 15,000 acres of open water (backyard ponds) than this would
not necessarily be good as far as habitat value.

For the state of Indiana, there was a net change of 23,403 wetlands with a gain of 57,070 acres
(Table 6 and 7). However, there was a loss of 11,340 emergent wetlands and 3,218 forested
wetlands during this time and a gain of 38,705 open water wetlands. When looking at the wetland
acreage during this time period, forested wetlands (-8,094), Scrub-shrub wetlands (-1,503), and
Shore wetlands (-183) lost wetlands. The wetland losses were mostly limited to the north and
north-central part of the state, with the exception of Dearborn County (Figure 4 and 5).

Table 6. The net change in wetland numbers from 1980/88 to 2005

AQUATIC BED EMERGENT FORESTED SCRUB-SHRUB  OPEN WATER SHORE OTHER

Number % Num ber % Num ber % Number % Number % Number % Number % TOTAL
CONVERTED NUMBER 252 1% 20,665 56% 4895  13% 1,479 4% 9419  25% 153 0% 80 0% 36,943
ADDITIONAL NUMBER 387 1% 9325 15% 1,677 3% 573 1% 48124  80% 0 0% 260 0% 60,346
TOTAL 135 -11,340 -3,218 -906 38,705 -153 180 23,403

Table 7. The net change in wetland acreage from 1980/88 to 2005

AQUATIC BED EMERGENT FORESTED SCRUB-SHRUB OPEN WATER SHORE OTHER

Acres % Acres % Acres % Acres % Acres % Acres % Acres % TOTAL
CONVERTED ACRES 133 0% 21,711 48% 14,543 0 2,996 7% 4,783 0 183 0 1,066 2% 45416
ADDITIONAL ACRES 419 0% 26,723 26% 6,450 6% 1,494 1% 43479  42% 0 0% 23922 23% 102,486
TOTAL 285 5,012 -8,094 -1,503 38,696 -183 22,856 57,070
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Figure 4. The number of net wetland change by county
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Figure 4. The acreage of net wetland change by county
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Field Verification

The overall accuracy based on the field verification of the wetland delineation was 86%. This
means that 86% of the time the updated NWI classified a wetland, it was verified as a wetland in the
field. Of the wetlands that were misclassified, 86% were when the interpretation was an emergent
wetland, but the field verification was converted and 14% were when the interpretation was
converted and the field verification was an emergent wetland. There was a four year time
difference (2005 — 2009) between the photo acquisition for the interpretation and the field
verification, which may account for some of the misclassification.

The overall accuracy based on the field verification of the wetland class identification was 79%.
This means that 79% of the time the updated NWI classified a wetland class (open water, aquatic,
emergent, shrub, forested), it was verified as they wetland class in the field. A majority of the
within class errors were on wetlands there were under an acre in size and were between the
emergent, shrub, and forested class. These classes are very hard to distinguish from aerial photos at
that size due to nearby tree cover.

Additional work needs to be done on the assessment of the updated NWI classification, particularly

in the between class errors and determining the accuracy of the classes at different scales. It would
also be interesting to determine if there were significant differences between counties.
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Appendix A — Data Contacts

NW!I Data Contacts:

Bruce R. Droster

Cartographer & NWI MGD Administrator

U.S. Geological Survey, Water Resources Division
Cartography and Publishing Program

505 Science Drive

Madison, Wl 53711-1061

Phone: (608) 238-9333 ext. 144
Fax: (608) 238-9334
email: bdroster@usgs.gov

Brian Huberty

Regional NWI Coordinator
U.S. Fish and Wildlife Service
R-3 Ecological Services

1 Federal Drive, Mail Stop 4056
Ft Snelling, MN 55111-4056

Direct Phone (612) 713-5332
Fax (612) 713-5292
brian_huberty@fws.gov

Indiana Photos

http://www.in.gov/ingisi/projects/ortho/index.html

2003 NAIP imagery & DEM

Jennifer Dubeansky

Indiana Geographic Information Council, Inc
140 N. Senate Avenue, Room 306
Indianapolis, IN 46204

Indianapolis, IN 46204

Phone: 317.234.2924

Email: jdubeansky@igic.org

2005 CIR

Anna Radue

Database and GIS Specialist
Indiana University

2711 East 10" Street
Bloomington, IN 47408
Phone: 812-855-6865

Email: aradue@indiana.edu
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Great Lakes NWI Field Verification: Directions

DUCKS UNLIMITED
Crear Lales Arlancic Reghora] Office

Enclozed in thiz packet are: (1) a map of the wetland and its surrounding area, (2) a wetland clazsification
documnent, (3} a dizpozable digital camera (if you had requested one from Ducks Unlimited). Wetlands have
been randomly selected for field verification but have been limited to within 50 meters of a road to allow
verification from the roadside. Please respect private property rights.

Preparations:

1. Review the Wetlands and Deepwater Habitats Clasgification diagram and the Great Lakes MW
Field Verification: Wetlands and Deepwater Habitats Classification Explanation document. If you
are not already, familiarize yourzelf with the wetland classifications emploved by the NWIL

2. Review the wetland's maps and determine the wetland's location.

I the field:

3. ldentify the wetland’s class. Conzult the classification documents if necessary and circle the
corresponding classification on the wetland's mag.

5. Photogragh the wetland. Record on the wetland's map the photogragh’s number and in what
direction the photograph was taken by drawing an arow on the map.

&. Write any additional comments or nofes conceming the classification on the back of the map.

Finizhing:

7. Ifusing your own camera, burn all photegraghs onto CD. I using the disposable digital provided by
Ducks Unlimited, gsimply mail the camera in its accompanying envelope.

8. Return the wetland's map and photo CD {if using your own digital) to Ducks Unlimited.

9. Please record the dates and time you spent doing the field verification and send with the wetlands
information. This data will be used for reporting and tracking the time involved in collecting the field
imformation.

10. Youre done. Thanks for your time and help!

For questicns, comments or problems, contact:

Roblb Macleod

Ducks Unlimited, Inc.

Great LakesiAtlantic Regional Office
Ann Arbar, M1 42103

(734) 623-2000
rmaclecd@ducks.org
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Photograph # Camera #

{if applicable)
Please indicate the direction of the photo by placing a POINT (indicating camera location)
and an ARROW (indicating direction of photo) on the above map.

Wetland Class: Circle only one class, choose the class that fits the best
and provide additional comments:

Open Water Aquatic Bed Scrub/shrub Forested
Emergent Unconsolidated Converted (choose 1 of the following):
Bottom -Agriculture - Development - Recreation

Great Lakes NWI
Field Verification Map

Lapeer County, Michigan
Wetland #3884606

Photo Date

Comments:

Confinue comments on the back of sheef

Jun 21, 2007
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Great Lakes NWI Field Verification:
WETLANDS AND DEEPWATER HABITATS CLASSIFICATION DESCRIPTIONS

Unconsalidated Bottom (UB)

Definition: open water with no vegetation. Unconscolidated bofttom includes all
weiland habitats with at least 25% cower of particles smaller than stones, and a
wegetative cover less than 30%.

Description: unconsolidated bottoms are characterized by the lack of large stable
surfaces for plant and animal attachment and may possess cobble-gravel, sand,
mud or organic bottoms. Shallow ponds with ittle or no vegetation and backyard
ponds are typical of the class.

Aguatic Bed (AB)

Definition: submergent vegetation often including lily pads. Aguatic bed includes
wetlands dominated by plants that grow principally on or below the surface of the
water for mast of the growing season in most years.

Description: aquatic beds represent a diverse group of plant communities that
require surface water for optimum growth and reproduction. They are best
developad in relatively permanent water or under conditions of repeated flooding.
The plants are either attached to the substrate or float freely in the water above
the bottom or on the surface. Aquatic bed weillands may be characterized by
algas, aguatic moss, rooted vascular, floating vascular, unknown submergent
and unknown surface lifs.

Emergent (EM)

Definition: emergent wetlands are characterized by erect, rooted, herbaceous hydrophytes,
excluding mosses and lichens. This vegstation is present for most of the growing season in most
years. Thess wetlands are usually dominated by perennial plants. Al water regimes are
included except subtidal and irregularly exposed.

Description: In areas with relatively stable climatic conditions, emergent wetlands maintain the
=ame appearance year after year. In other areas, such as the prairies of the central United
States. violent climatic fluctuations cause them to revert to an open water phase in some years.
Emergent wetlands are found throughout the United States and are known by many names,
including marsh, meaadow, fen, prairie pothole, and slough.




Scrub-Shrub (§5)

Definition: scrub-shrub includes areas dominated by woody vegetation l2ss than 8
meters (20 feat) tall. The vegetation species include true shrubs, young tress, and
trees or shrubs that are small or stunted because of environmental conditions.

Deseription: scrub-shrub wetlands may represent a successional stage leading o
forestad wetlands, or they may be relatively stablz communities. They ars on of
the most widespread classes in the United States. Scrub-shrub wetlands are
known by many names, such as shrub swamp, shrub carr, bog, and pososin. Faor
practical reasons, the scrub-shrub class includes forests composed of young trees
less than & meters tall.

Forested (FO)

Definition: forested wetlands are characterized by woody vegetation that is &
meters tall or taller.

Description: forested wetlands are most commen in the eastem United States and
in those sections of the West where maisture is relatively abundant, particularly
along rivers and in the mountains. They normally possess an overstory of frees,
and understory of young frees or shrubs, and an herbacsous laysr.

Converted (Converted)

Definition: wetlands that have been converted to other uses such as agricufturs,
development, recraation, ste.

Description: converted wetlands were weilands in the past but have since baen
converted to other uses. Wetllands that show plow lines or support crops, for
axample, will have been converied for agricuttural purposas. Wetlands perhaps
supporting built structures have been converted for development. Wedands
supporting golf courses will have been converted for recreational purpeses.
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Appendix C — Wetland Statistics by
County

Ducks Unlimited, Inc. 109 11/11/2010



COUNTY Original # Full Convert#  Part Convert# Total Convert# Total Convert % Additionl # Net Wetland #  Original Acres  Convert Acres  Additional Acres Avg Size Conv  Avg Size Add Net Acreage
Adams 1,065 92 6 98 9% 671 573 3,133.63 82.60 831.61 0.84 1.24 749.01
Allen 4,473 699 100 799 18% 2,079 1,280 14,514.86 1,117.92 2,794.19 1.40 1.34 1,676.26
Bartholomew 2,450 92 48 140 6% 713 573 14,402.49 263.96 707.39 1.89 0.99 443.43
Benton 779 57 7 64 8% 91 27 1,670.27 58.52 253.22 0.91 2.78 194.69
Blackford 1,043 102 18 120 12% 317 197 2,508.22 122.03 437.87 1.02 1.38 315.84
Boone 2,071 370 64 434 21% 691 257 5,409.39 360.09 845.71 0.83 1.22 485.62
Brown 2,138 50 5 55 3% 684 629 6,708.86 46.64 547.39 0.85 0.80 500.75
Carroll 2,087 371 40 411 20% 242 -169 7,982.73 568.76 656.79 1.38 271 88.03
Cass 3,425 630 35 665 19% 186 -479 9,729.14 744.50 286.87 1.12 1.54 -457.62
Clark 3,298 337 43 380 12% 968 588 6,365.29 392.64 835.38 1.03 0.86 442.75
Clay 3,690 365 17 382 10% 361 -21 9,343.59 280.30 732.59 0.73 2.03 452.29
Clinton 2,042 570 99 669 33% 156 -513 6,348.40 639.66 114.30 0.96 0.73 -525.36
Crawford 1,648 80 1 81 5% 807 726 3,190.02 26.12 411.29 0.32 0.51 385.17
Daviess 3,424 583 53 636 19% 1,196 560 15,675.45 651.30 1,199.44 1.02 1.00 548.15
DeKalb 5,822 1,340 47 1,387 24% 637 -750 13,649.94 1,564.91 781.94 1.13 1.23 -782.96
Dearborn 2,966 169 51 220 7% 1,246 1,026 6,033.23 128.40 1,110.86 0.58 0.89 982.46
Decatur 1,451 150 39 189 13% 430 241 3,906.39 174.97 524.25 0.93 1.22 349.28
Delaware 2,014 118 35 153 8% 774 621 7,554.08 117.78 726.05 0.77 0.94 608.27
Dubois 3,850 412 2 414 11% 954 540 14,040.17 352.61 1,323.90 0.85 1.39 971.29
Elkhart 4,777 1,083 142 1,225 26% 1,011 -214 17,199.95 1,073.60 841.08 0.88 0.83 -232.52
Fayette 728 59 19 78 11% 181 103 2,511.96 101.51 175.16 1.30 0.97 73.65
Floyd 1,479 179 9 188 13% 481 293 1,373.36 67.23 275.09 0.36 0.57 207.85
Fountain 1,348 91 49 140 10% 120 -20 10,480.18 374.60 209.51 2.68 1.75 -165.09
Franklin 2,025 124 24 148 % 922 774 7,109.84 141.78 770.83 0.96 0.84 629.05
Fulton 4,299 500 23 523 12% 484 -39 14,081.57 694.11 757.01 1.33 1.56 62.90
Gibson 3,508 141 54 195 6% 420 225 30,152.48 732.38 1,390.87 3.76 3.31 658.49
Grant 1,891 185 13 198 10% 496 298 4,948.67 227.45 908.83 1.15 1.83 681.37
Greene 5,005 383 33 416 8% 2,004 1,588 12,348.64 372.87 2,388.25 0.90 1.19 2,015.38
Hamilton 1,784 288 124 412 23% 1,638 1,226 10,130.61 631.73 2,166.88 1.53 1.32 1,535.15
Hancock 1,245 194 42 236 19% 520 284 3,379.62 150.41 562.18 0.64 1.08 411.77
Harrison 4,246 189 9 198 5% 1,103 905 5,372.70 113.33 688.52 0.57 0.62 575.18
Hendricks 1,245 68 41 109 9% 1,030 921 2,998.14 99.32 1,312.53 0.91 1.27 1,213.21
Henry 1,962 153 39 192 10% 446 254 4,502.16 191.51 864.66 1.00 1.94 673.16
Howard 1,432 202 16 218 15% 386 168 5,635.38 398.09 880.82 1.83 2.28 482.73
Huntington 1,638 67 17 84 5% 742 658 6,381.24 106.30 8,561.03 1.27 11.54 8,454.74



COUNTY Original # Full Convert#  Part Convert# Total Convert# Total Convert % Additionl # Net Wetland #  Original Acres  Convert Acres  Additional Acres Avg Size Conv  Avg Size Add Net Acreage
Jackson 3,787 142 52 194 5% 879 685 26,418.84 473.67 661.22 2.44 0.75 187.56
Jasper 2,979 449 19 468 16% 760 292 9,361.39 760.55 2,416.73 1.63 3.18 1,656.18
Jay 1,589 183 21 204 13% 526 322 5,237.92 347.81 587.27 1.70 1.12 239.46
Jefferson 3,127 279 3 282 9% 503 221 9,315.75 298.74 282.97 1.06 0.56 -15.77
Jennings 2,808 215 74 289 10% 659 370 8,343.90 274.81 758.72 0.95 1.15 483.92
Johnson 1,356 105 11 116 9% 1,036 920 5,144.99 164.32 1,018.07 1.42 0.98 853.74
Knox 4,317 247 78 325 8% 539 214 23,069.06 798.34 1,273.99 2.46 2.36 475.65
Kosciusko 9,252 1,662 264 1,926 21% 678 -1,248 38,097.48 1,724.83 898.59 0.90 1.33 -826.24
LaGrange 7,457 1,886 130 2,016 27% 309 -1,707 30,086.54 2,674.54 226.83 1.33 0.73 -2,447.72
LaPorte 4,641 451 123 574 12% 561 -13 27,528.11 1,256.77 1,338.12 2.19 2.39 81.35
Lake 4,198 415 183 598 14% 720 122 23,103.69 1,716.59 1,429.48 2.87 1.99 -287.11
Lawrence 3,746 766 15 781 21% 763 -18 6,691.26 288.44 600.34 0.37 0.79 311.90
Madison 1,887 274 70 344 18% 450 106 7,501.12 448.72 406.39 1.30 0.90 -42.32
Marion 1,437 212 80 292 20% 1,759 1,467 9,365.71 509.52 2,180.03 1.74 1.24 1,670.51
Marshall 4,601 1,045 429 1,474 32% 864 -610 20,731.47 2,068.30 1,255.30 1.40 1.45 -813.00
Martin 1,835 221 28 249 14% 386 137 7,437.66 178.27 362.58 0.72 0.94 184.31
Miami 1,823 298 21 319 17% 461 142 5,293.48 401.14 891.99 1.26 1.93 490.85
Monroe 2,025 262 3 265 13% 442 177 14,614.16 238.98 443.79 0.90 1.00 204.81
Montgomery 1,933 232 58 290 15% 240 -50 7,264.78 338.45 438.47 1.17 1.83 100.01
Morgan 3,072 114 50 164 5% 963 799 9,817.84 166.65 1,287.24 1.02 1.34 1,120.59
Newton 1,539 416 47 463 30% 539 76 9,454.56 737.06 1,603.55 1.59 2.98 866.49
Noble 8,530 1,466 72 1,538 18% 578 -960 31,448.33 1,485.03 795.93 0.97 1.38 -689.10
Ohio 1,031 46 46 4% 214 168 1,575.72 7.97 156.74 0.17 0.73 148.77
Orange 2,611 105 112 4% 786 674 7,946.75 44.56 276.53 0.40 0.35 231.97
Owen 3,035 87 18 105 3% 1,437 1,332 8,688.15 182.45 1,085.80 1.74 0.76 903.35
Parke 1,798 106 25 131 7% 336 205 9,981.33 120.47 1,471.06 0.92 4.38 1,350.59
Perry 2,303 121 6 127 6% 679 552 5,683.25 78.78 406.89 0.62 0.60 328.11
Pike 4,861 438 50 488 10% 1,100 612 22,829.89 1,040.46 1,494.46 2.13 1.36 454.01
Porter 3,289 311 85 396 12% 571 175 18,792.46 699.78 840.08 1.77 1.47 140.30
Posey 2,544 77 22 99 4% 385 286 25,178.89 173.87 3,810.60 1.76 9.90 3,636.74
Pulaski 3,580 495 30 525 15% 283 -242 12,675.18 760.16 804.85 1.45 2.84 44.69
Putnam 1,809 141 38 179 10% 642 463 5,828.52 70.12 731.83 0.39 1.14 661.71
Randolph 1,680 176 62 238 14% 360 122 7,066.85 246.62 400.20 1.04 1.11 153.58
Ripley 3,204 242 92 334 10% 1,290 956 8,090.41 181.01 1,185.14 0.54 0.92 1,004.13
Rush 1,236 230 109 339 27% 138 -201 5,753.29 333.47 197.02 0.98 1.43 -136.45
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COUNTY Original # Full Convert#  Part Convert# Total Convert# Total Convert % Additionl # Net Wetland #  Original Acres  Convert Acres  Additional Acres Avg Size Conv  Avg Size Add Net Acreage
Scott 2,075 78 20 98 5% 551 453 8,595.39 122.58 406.53 1.25 0.74 283.95
Shelby 1,444 112 50 162 11% 312 150 7,306.20 198.76 540.34 1.23 1.73 341.57
Spencer 3,497 444 0 444 13% 1,034 590 12,516.55 246.86 2,284.17 0.56 221 2,037.31
St. Joseph 3,482 527 252 779 22% 660 -119 12,817.18 938.43 937.03 1.20 1.42 -1.40
Starke 2,381 267 249 516 22% 384 -132 13,955.76 860.77 777.07 1.67 2.02 -83.70
Steuben 6,857 1,111 64 1,175 17% 277 -898 27,889.70 1,388.48 1,839.14 1.18 6.64 450.67
Sullivan 4,074 514 42 556 14% 584 28 24,073.72 579.30 1,462.99 1.04 2,51 883.69
Switzerland 2,315 136 8 144 6% 827 683 4,803.06 37.59 534.69 0.26 0.65 497.10
Tippecanoe 2,592 363 50 413 16% 381 -32 13,056.94 815.09 934.82 1.97 245 119.73
Tipton 940 172 47 219 23% 111 -108 3,691.50 560.09 250.94 2.56 2.26 -309.15
Union 561 45 10 55 10% 132 77 4,031.43 57.46 110.53 1.04 0.84 53.08
Vanderburgh 1,689 149 43 192 11% 703 511 4,886.30 343.89 1,123.96 1.79 1.60 780.07
Vermillion 1,093 107 31 138 13% 330 192 6,473.49 206.93 1,518.50 1.50 4.60 1,311.56
Vigo 3,011 191 87 278 9% 775 497 18,720.74 514.44 3,599.87 1.85 4.64 3,085.43
Wabash 2,116 26 15 41 2% 510 469 9,786.37 107.24 8,148.25 2.62 15.98 8,041.01
Warren 1,204 75 28 103 9% 216 113 6,586.14 189.88 391.27 1.84 1.81 201.40
Warrick 5,843 728 730 12% 1,144 414 21,978.94 589.36 2,923.81 0.81 2.56 2,334.45
Washington 3,636 287 288 8% 1,197 909 8,714.18 100.93 659.24 0.35 0.55 558.31
Wayne 1,785 97 48 145 8% 391 246 7,395.79 192.27 399.01 1.33 1.02 206.74
Wells 1,563 80 9 89 6% 695 606 3,5658.82 86.42 544.59 0.97 0.78 458.17
White 3,468 644 18 662 19% 124 -538 8,998.15 1,100.01 183.24 1.66 1.48 -916.77
Whitley 4,865 1,391 178 1,569 32% 985 -584 11,441.77 1,718.00 1,022.83 1.09 1.04 -695.17
TOTAL 259,759 31,952 4,991 36,943 12 60,346 23,403 1,007,469 45,416 102,486 115 177 57,070
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